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Veiligheid

Inleiding

Voor een efficiënt en veilig gebruik is het van essentieel belang om deze paragraaf en alle gerelateerde onderwerpen te 
lezen, voordat u de software voor het eerst gaat gebruiken. Tevens is het belangrijk dat u de inhoud van deze handleiding 
begrijpt, voor u het product begint te gebruiken. Het is aan te raden met enige regelmaat de procedures en 
voorzorgsmaatregelen door te nemen. 

De software is alleen bedoeld om gebruikt te worden door gekwalificeerd en opgeleid personeel.

suiteDXT/suiteHEART®-software heeft een verwachte levensduur van 7 jaar vanaf de oorspronkelijke uitgavedatum.

VOORZICHTIG: De Amerikaanse nationale wet beperkt de verkoop, distributie en het gebruik van dit apparaat 
door of in opdracht van een arts.

De termen gevaar, waarschuwing en voorzichtig worden in deze handleiding gebruikt om risico's aan te duiden en om een 
gradatie of niveau van ernst aan te geven. Risico wordt gedefinieerd als een bron van mogelijke schade aan een persoon. 
Maak uzelf vertrouwd met de terminologie-omschrijvingen in de volgende tabel:

Gebruiksaanwijzingen

suiteHEART® Software is een analytische softwaretool die reproduceerbare hulpmiddelen biedt voor het beoordelen en 
rapporteren van medische beelden. suiteHEART® Software kan medische beelden van een MR-systeem importeren en 
weergeven in een weergavegebied op het computerscherm. Het beeldgebied verschaft toegang tot meerdere 
onderzoeken en series van afbeeldingen die zijn opgebouwd uit vele schijven en fasen. Opeenvolgende fasen van 
afbeeldingen kunnen worden getoond in filmmodus om visualisatie te vergemakkelijken.

Tabel 1:  Veiligheidsterminologie

Grafisch Definitie

GEVAAR:

„Gevaar” wordt gebruikt voor situaties of handelingen die zullen leiden tot ernstig lichamelijk 
letsel, overlijden of aanzienlijke eigendomsschade wanneer de aanwijzingen worden 
genegeerd.

WAARSCHUWING: 

Waarschuwing wordt gebruikt voor situaties of handelingen waaraan een specifiek gevaar is 
verbonden.

VOORZICHTIG: 

Voorzichtig wordt gebruikt voor situaties of handelingen waaraan een mogelijk gevaar is 
verbonden.
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Een rapportinputinterface is ook beschikbaar. Meettools in de rapportinterface maken het mogelijk om snel en 
betrouwbaar een compleet klinisch rapport van een beeldonderzoek in te vullen. Beschikbare tools zijn onder andere: 
punt, afstand, gebied en volumemeettools, zoals uitstootfractie, hartfunctie, einddiastolisch volume, eindsystolisch 
volume en volumestroommetingen.

Halfautomatische tools zijn beschikbaar voor linkerventriculaire contourdetectie, klepvlakdetectie, vatcontourdetectie 
voor stroomanalyse, signaalsterkteanalyse voor myocard- en infarctomvangmeting, en T2*-analyse.

De resultaten van de meettools worden geïnterpreteerd door de arts en kunnen worden doorgegeven aan verwijzende 
artsen.

Mits ze door een gekwalificeerde arts worden geïnterpreteerd, zijn deze tools nuttig voor het helpen bepalen van een 
diagnose.

Beoogd gebruik

suiteHEART® Software is bedoeld om opgeleid klinisch personeel te helpen bij de kwalificatie en kwantificering van de 
hartfunctie. De software biedt de hulpmiddelen om de parameters van de DICOM-afbeeldingen aan te passen en biedt 
presentatiestaten waar de gebruiker in de loop van de tijd verschillende MRI-afbeeldingen van het hart en het vaatstelsel 
kan beoordelen. Bovendien biedt de software hulpmiddelen voor het meten van lineaire afstanden, gebieden en volumes 
die kunnen worden gebruikt om de hartfunctie te kwantificeren. Ten slotte biedt de software de hulpmiddelen voor 
volumestroommetingen en de mogelijkheid om stroomwaarden te berekenen.

Ondersteunde DICOM-beeldformaten

suiteHEART® Software ondersteunt het volgende DICOM-formaat; MR en verbeterde MR. Raadpleeg de handleiding van 
de suiteHEART® Software DICOM-conformiteitsverklaring voor meer informatie over ondersteunde formaten.

VOORZICHTIG: Gegevens die zijn opgeslagen als een DICOM-afbeelding en die zijn geïmporteerd door een 
externe PACS, zijn mogelijk niet compatibel voor weergave van suiteHEART® Software. 
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Opmerkingen betreffende veiligheid

WAARSCHUWING: De applicatie helpt alleen bij de analyse van de afbeeldingen en levert niet automatisch 
kwantificeerbare resultaten op. Het gebruiken en plaatsen van kwantitatieve metingen is 
aan de gebruiker. Onnauwkeurige metingen kunnen leiden tot verkeerde diagnoses. 
Metingen dienen alleen te worden verricht door goed opgeleid en gekwalificeerd personeel. 

WAARSCHUWING: Artefacten op een afbeelding kunnen verkeerd worden geïnterpreteerd, wat kan leiden tot 
een verkeerde diagnose. Gebruik voor het stellen van een diagnose geen beelden die 
artefacten bevatten. Analyses dienen alleen te worden verricht door goed opgeleide en 
gekwalificeerde gebruikers.

WAARSCHUWING: Als afbeeldingen geen patiëntnaam of ID bevatten, kan de patiënt een verkeerde diagnose 
krijgen. Gebruik geen afbeeldingen zonder patiëntnaam en ID voor diagnose. Bevestig voor 
de analyse visueel de patiëntinformatie.

VOORZICHTIG: Het gebruik van afbeeldingen waarop een beeldfilter is toegepast, kan leiden tot andere 
resultaten. De gebruiker dient discretie te betrachten voor het analyseren van afbeeldingen 
waarvan de pixelintensiteit is gecorrigeerd. De software zal een waarschuwing geven bij het 
laden van gefilterde afbeeldingen.

Risico's van de apparatuur

VOORZICHTIG: Het gebruik van beschadigde of onbetrouwbare apparatuur kan de patiënt in gevaar brengen 
doordat de diagnose wordt vertraagd. Zorg ervoor dat de apparatuur goed functioneert.

VOORZICHTIG: Applicaties kunnen worden uitgevoerd op apparatuur met een of meer harde schijven, waarop 
medische gegevens van patiënten kunnen voorkomen. In sommige landen kunnen richtlijnen 
betreffende het verwerken van persoonlijke gegevens en de vrije circulatie daarvan op het 
gebruik van zulke apparatuur van toepassing zijn. Het vrijgeven van persoonlijke gegevens kan 
leiden tot juridische stappen, afhankelijk van het betreffende overheidsorgaan. Het wordt 
daarom sterk aanbevolen om de toegang tot patiëntbestanden te beschermen. De gebruiker is 
verantwoordelijk voor kennis van de wetten betreffende patiëntinformatiebeheer.
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Aan de slag

De applicatie opstarten en beëindigen

suiteHEART® Software is een applicatie die kan worden gebruikt voor analyse, beoordeling en rapportage van cardiale 
MRI-onderzoeken (Magnetic Resonance Imaging). Deze handleiding geeft een gedetailleerde uitleg van de 
gebruikersinterface van suiteHEART® Software en de workflow voor het uitvoeren van kwantitatieve analyses van MRI-
hartscans.

suiteHEART® Software opstarten

1. Start suiteDXT via de snelkoppeling op het bureaublad.

OPMERKING: Zowel suiteDXT- als suiteHEART® Software-applicaties moeten (tegelijkertijd) actief blijven om de
noodzakelijke bestandsoverdracht(en) tussen de applicaties te vergemakkelijken.

2. Ga op het hoofdscherm naar het keuzemenu Applicatie starten en selecteer suiteHEART® Software.

FIGUUR 1. Start de applicatie op

3. Selecteer een onderzoek uit de onderzoekslijst en voer een van de volgende handelingen uit:

• Selecteer de opstartknop.
• Klik met de rechtermuisknop en selecteer „Opstarten met <geselecteerde applicatie>”.
• Dubbelklik op het onderzoek.

4. Onderzoeken met afbeeldingen waarop pixelintensiteitsfilters zijn toegepast, worden voor het openen van het
onderzoek in een berichtvak weergegeven.

OPMERKING: De schermresolutie moet worden ingesteld op 1920x1080 of hoger, anders start de software niet.

WAARSCHUWING: Het gebruik van afbeeldingen waarop pixelintensiteitsfilters zijn toegepast voor analyse kan 
resulteren in onnauwkeurige resultaten.
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suiteHART® Software beëindigen

Selecteer om de applicatie te beëindigen File > Exit (Bestand > beëindigen).

FIGUUR 2. suiteHART® Software afsluiten
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Overzicht van gebruikersinterface

Overzicht

De suiteHEART® Software-interface heeft drie hoofdpanelen zoals getoond in Figuur 1.

• Analyseoverzicht: Biedt analysetools voor elke analysemodus.
• Afbeeldingsoverzicht: Biedt snelle toegang voor beeldanalyse en beoordelingsfuncties.

- Bestaat uit miniatuuroverzichten, bewerkingsvenster en modusoverzicht.

• Rapportoverzicht: Biedt de tools die worden gebruikt voor gestructureerde rapportage.

FIGUUR 1. Drie hoofdpanelen: Analyseoverzicht, afbeeldingsoverzicht, rapportoverzicht

Analyseoverzicht

Miniatuuroverzicht

Rapportoverzicht

Afbeeldingsoverzicht

Bewerkingsvenster Modusoverzicht
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Analyse-/Viewermodi

OPMERKING:  Patent Foramen Ovale (PFO) analyse kan worden geselecteerd in het keuzemenu voor bestanden of met 
Ctrl 5 op het toetsenbord.

Serienavigatie

Om afbeeldingen te bekijken of series binnen het geselecteerde onderzoek te wijzigen, gebruikt u de linker en rechter 
pijltjestoetsen bovenaan het Afbeeldingsoverzicht. Het keuzemenu van het seriebestand, links van de knop Filter, kan ook 
worden gebruikt om de serie te selecteren. Series met analyses of interessegebieden worden vetgedrukt aangeduid, zoals 
weergegeven in Figuur 2.

FIGUUR 2. Serienavigatie

Tabel 1:  Analysemodi

Functie- 
analyse

Stroom-  
analyse

Myocard- 
evaluatie

T1- 
Mapping

T2- 
Mapping

Tijdsduur- 
analyse

T2*-
analyse

Tabel 2:  Viewermodi

Viewer Virtual
FellowTM

3D/4D 
Viewer
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Bewerkingsvenster en modusoverzicht

Als u met de rechtermuisknop op een afbeelding in het Afbeeldingsoverzicht klikt, worden beeldmanipulatietools geactiveerd. 

Bestandsmenuopties

Analyse selecteren – Selecteert de analysemodus (Functie, Stroom, Myocardiale evaluatie, Tijdsduur, PFO, T2*, T1-Mapping, 
T2-Mapping en 3D/4D) 
DB doorbladeren – Opent de lokale database
Onderzoek wisselen – Toont beschikbare onderzoeken voor snelle toegang
Rapport vooraf bekijken – Vooraf bekijken van het opgemaakte rapport
Rapport afdrukken – Hiermee drukt u het rapport af
Approve Exam – Keurt de uiteindelijke versie van een rapport goed en sluit het af met een ondertekening
Goedgekeurd onderzoek laden – Herstelt een eerder geopend rapport
Exit – Sluit de applicatie af waarbij de actuele analyseresultaten worden opgeslagen in een secundaire-opnameserie (SCPT).

 Toolsmenuopties

Voorkeuren >
Voorkeuren bewerken – Opent de voorkeureneditor om de software- en sjabloonvoorkeuren in te stellen
Voorkeuren importeren – Herstelt gebruikersvoorkeuren en macro's
Voorkeuren exporteren – Exporteert alle gebruikersvoorkeuren

Exporteren >

Rapport exporteren – Genereert een rapport op basis van de huidige analyse en slaat het op als een secundaire-
opnameserie (SCPT).
Rapport exporteren naar Excel – Genereert een Excel-spreadsheet met analyseresultaten.
Cine DICOM exporteren – Slaat een DICOM-cine van de momenteel geselecteerde serie op als een SCPT-bestand.
Cine-bestanden exporteren – Exporteert momenteel geselecteerde serieafbeeldingen naar een van de geselecteerde 
bestandsformaten. Beschikbare formaten zijn: gecomprimeerde QuickTime-film, JPEG, TIFF, GIF, PNG of niet-
gecomprimeerde AVI-film.
Exporteren naar Matlab – Exporteert een Mat-bestand in binaire vorm. (Alleen beschikbaar op licentie)
Rapport exporteren naar XML – Exporteert rapport als een XML-bestand.

Tabel 3:  Beeldmanipulatietools

Venster/Niveau

Pannen

Zoom

Roteren

Omdraaien

Verzenden naar rapport

Parameters scannen

Resetten
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Rapportdatabase
Toggle Annotation – Wisselt de weergave van de ROI-aantekeningen
Lijndikte wisselen – Wisselt tussen lijndikte van annotaties.
Referentieregels wisselen – Wisselt tussen referentieregels op afbeeldingen.
Toggle FOV – Beeldveld wisselen
Venster/Niveau omdraaien – Draait de venster/niveau-weergave om

Helpmenuopties

Gebruiksaanwijzing – suiteHEART® Software Gebruiksaanwijzing
DICOM-conformiteitsverklaring – suiteHEART® Software DICOM-conformiteitsverklaring
Over suiteHEART® – Versie-informatie over de applicatie 
Sneltoetsen – Toetsenbordfuncties

Beeldweergavebesturing

De faseschuifregelaar  regelt de selectie van de cine-fase.

De afbeeldingsstappictogrammen  maken navigatie per plakje 
mogelijk wanneer de miniatuurweergave in plakjes of fasen gebeurt.

Op uw toetsenbord regelen de pijltoetsen links en rechts de navigatie tussen plakjes en de pijltoetsen omhoog en omlaag 
bepalen de navigatie tussen fasen, afhankelijk van uw voorkeursinstelling. 

OPMERKING:  De x- (segment) en y- (fase) as kunnen worden verwisseld. Zie  Figuur 4, „Diversenpaneel,” op pagina 33. 
Als ze verwisseld zijn, moet de applicatie opnieuw worden gestart.
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Modusweergaven

De modusweergave heeft drie beschikbare formaten:

Cinemodus

- Cine: Regelt het bekijken van een cine-beeld in een filmmodus.

- Cine-modusbalk: Definieert het begin- en eindframe van de film.

- Frames per seconde (FPS): Klik op de pijl of voer een waarde in het tekstvak in om de cine-snelheid te wijzigen

- Afspeelpictogram: Staat naast de cine-modusbalk

- Pauzepictogram: Staat naast de cine-modusbalk

Matrixmodus

Matrixmoduspictogram: Toont de afbeeldingen in plakjes/fasen in rastervorm

De voor analyse geselecteerde afbeeldingen zijn gemarkeerd en de endocard- en epicardcontouren worden vermeld.  
De matrixmodus kan worden gebruikt om in fasen te navigeren. De ED- en ES-toetsen kunnen worden gebruikt om de 
fasen in de matrix te selecteren. Door op een cel in de matrix te klikken, wordt de schijf in de Image Editor geladen.

De matrixmodus ondersteunt het verwijderen van contouren op een plaklocatie binnen een rij of kolom, wat kan worden 
uitgevoerd door het plaknummer of fasenummer te selecteren en met een rechtermuisklik Verwijderen te selecteren. 
Contouren uit een enkele fase, een groep fasen of plakjes kunnen ook worden gemaakt door de gewenste fase en 
plaklocaties op de matrix rechtstreeks te selecteren en met een rechtermuisklik Verwijderen te selecteren.

OPMERKING:  De x- (segment) en y- (fase) as kunnen worden verwisseld. Zie  Figuur 4, „Diversenpaneel,” op pagina 33. 
Als ze verwisseld zijn, moet de applicatie opnieuw worden gestart.
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FIGUUR 3. Matrixmodus

De matrixmodus wordt gebruikt om de eindsystolische en einddiastolische fasen te beoordelen en toe te wijzen. Het kan 
worden gebruikt in de enkele ED/ES-modus als de hartslag verandert tijdens acquisitie om een nauwkeurige meting te 
verkrijgen van eindsystolische en einddiastolische volumes. Selecteer de ES-toets en klik op de cellen in de matrixmodus 
om de gespecificeerde plak/fase als eindsystolisch in te stellen. Selecteer de ES-toets en klik op de cellen in de 
matrixmodus om de gespecificeerde plak/fase als einddiastolisch in te stellen. De volumes worden automatisch opnieuw 
berekend als de eindsystolische en -diastolische afbeeldingen zijn geselecteerd.

Referentiemodus

De Referentiemodus toont de lange-asweergave van een afbeelding terwijl de korte-asweergave wordt weergegeven in 
het Beeldbewerkingsvenster. De lange-asweergave is een orthogonale plak binnen een hoek van de weergegeven 
afbeelding in het bewerkingsvenster. Er is een keuzemenu van alle beschikbare orthogonale schijven, net als een toets om 
te schakelen tussen de weergaven van de referentieschijfindicatoren. Gebruik de min en plus om tussen plaklocaties te 
navigeren.

FIGUUR 4. Referentiebediening

FIGUUR 5. Referentiemoduspictogram
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Beeldmanipulatietools

Tabel 4:  Pictogrammen en namen

Schakelen tussen beoordeling van plak/fase

Venster/Niveau – Selecteer en gebruik de middelste muistoets om wijzigingen te maken

Pannen – Selecteer en gebruik de middelste muistoets om wijzigingen te maken

Zoom – Selecteer en gebruik de middelste muistoets om wijzigingen te maken

Roteren – Selecteer en gebruik de middelste muistoets om wijzigingen te maken

Horizontaal draaien – Draait de afbeelding horizontaal

Toepassingsgebied Alle – Past beeldmanipulatie toe op alle plakken

Toepassingsgebied Huidige tot Laatste – Past beeldmanipulaties toe van de huidige plak tot de 
laatste plak

Toepassingsgebied Alleen Huidige – Past beeldmanipulatie alleen toe op de huidige plak

Kijkvensterlay-out – wijzig kijkvensterlay-out

Vergelijkingsmodus – Wijzig naar vergelijkingsmodus

Beoordelingsmodus – Wijzig naar beoordelingsmodus

Referentieregels tonen – Schakelt referentieregels in/uit
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Kleurenkaartoverlay – Schakelt kleurenkaart voor plakclassificatie in/uit

Resetten – Stelt Venster/Niveau, Pannen, Zoom en Roteren opnieuw in op standaard, op basis van 
de instelling van het toepassingsgebied

Interessegebied – Geeft afmetingen van oppervlakte en omtrek aan

Dradenkruis – Geeft een steekproef van gegevens met één pixel

Lineair – Geeft afmeting van de afstand van een rechte lijn aan

Label – Zorgt voor de toevoeging van gebruikersannotatie in het Bewerkingsvenster

Hoek – Geeft hoekmeting aan

Zoekfunctie – Referentietool om beelden met dezelfde locatie automatisch te identificeren en 
weer te geven

Opheffen – Hef functionaliteit beschikbaar voor ROI-bewerking op

Vernieuwen – Klik op de knop om het Afbeeldingsoverzicht bij te werken met recent aan het 
netwerk toegevoegde afbeeldingen

Filter – Sorteert series op type pulssequentie volgens de analysemodus. Kan worden uitgeschakeld 
door ALLE te selecteren. Filters kunnen worden ingesteld onder Voorkeuren. De filterknop is groen 
als een filter in gebruik is.

Tabel 4:  Pictogrammen en namen
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Sneltoetsen 

*De actieve instelling is afhankelijk van wat is gekozen in Voorkeuren.

Tabel 5:  Sneltoetsen

Functie Actie

Afbeelding zoomen Ctrl + Middelste Muistoets

Roteer afbeelding Ctrl + Shift + Middelste Muistoets

Draai afbeelding Shift + Middelste Muistoets

Venster/niveau Middelste muisknop

Cine Afspelen/Pauzeren Spatiebalk

Rapportdatabase Ctrl+D

Voorkeuren wijzigen Ctrl+E

Schakel beeldveld in Ctrl+F

Onderzoek goedkeuren Ctrl+G

Venster/niveau omdraaien Ctrl+I

Geef Dikke Lijnaantekening weer Ctrl+L

Open Bladeren in DB Ctrl+O

Druk rapport af Ctrl+P

Sluit of verlaat applicatie Ctrl+Q

Voorbeeldrapport openen Ctrl+R

Onderzoek wisselen Ctrl+S

Wissel annotatie Ctrl+T

Schakel referentielijnen in Ctrl+X

Annuleren Ctrl+Z

Functie Ctrl+1

Stroom Ctrl+2

Myocardevaluatie Ctrl+3

Tijdsduur Ctrl+4

PFO Ctrl+5

T2* Ctrl+6

T1-mapping Ctrl+7

T2-mapping Ctrl+8

3D/4D Ctrl+9

Navigeren tussen plakken* Linker en rechter pijltjestoetsen

Navigeren tussen fasen* Pijltjestoetsen omhoog en omlaag
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Analyseweergave

De analyseweergave is beschikbaar voor elke analysemodus.

FIGUUR 6. Elementen van analyseweergave

1. Meettabel, 2. Curveresultaten, 3. Wissen, 4. Diagrammen, 5. Tabellen

1

2

5

3

4
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Beoordeling van analyseweergave

Meettabel

FIGUUR 7. Resultaatparameters: Selecteer of deselecteer voor opname in het rapport door op het vakje naast de parameter te 
klikken

OPMERKING:  Klik direct op de tabel in de kolom om de hartslag in te voeren of te bewerken.

 Grafiek- en tabelresultaten

Resultaten kunnen worden weergegeven als een grafiek of in tabelvorm door op het gewenste pictogram in de 
rechteronderhoek van de analyseweergave te klikken.

FIGUUR 8. Grafiek- (links) en tabel- (rechts) pictogrammen: Geeft curveresultaten weer
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Tabel 6:  Analysetools

 Linker ventriculaire endocardiale ROI  Linker ventriculaire lokale ROI

 Linker ventriculaire epicardiale ROI
 Linker ventriculaire bloedpool ROI

 Rechter ventriculaire endocardiale ROI

 Rechter ventriculaire epicardiale ROI

 Annulus van mitralisklep

 Annulus van tricuspidalisklep

 Rechter ventriculair invoegpunt

 Linker ventriculaire papilaire spier ROI

 Rechter ventriculaire papillaire spier ROI

 Linker atriale ROI 

 Rechter atriale ROI

 Lange-as LV endocardiale ROI 

 Lange-as LV epicardiale ROI 

 Linker ventriculaire septale ROI
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Rapportoverzicht

suiteHEART® Software heeft vier rapportweergaven voor gestructureerde rapportage. Raadpleeg Gestructureerd 
rapporteren op pagina 144 voor meer informatie.

FIGUUR 9. Tabbladen Rapportage

- Voorbeeldrapport: Gebruikt voor het vooraf bekijken van een rapport

- Onderzoek goedkeuren: Gebruikt voor rapporthandtekening
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Doorzoekbare DB

Het venster Doorzoekbare DB geeft een overzicht van de actuele inhoud van de lokale database. Er kunnen onderzoeken 
in de lokale database worden bekeken en met de bedieningselementen kunt u kiezen welke onderzoeken u wilt bekijken 
of toevoegen aan de lijst met onderzoeken om tussen te wisselen.

FIGUUR 10. Venster Doorzoekbare DB

1. Lijst met lokale databases, 2. suiteHEART® Software databaseviewer, 3. Toevoegen aan Viewer-knop, 4. Verwijderen van Viewer-knop,
5. Viewer-knop bijwerken, 6. Annuleerknop

Functies van de doorzoekbare DB

De doorzoekbare DB verwijst standaard naar de lokale database.

1. Lijst lokale database – toont de onderzoeken die zijn opgeslagen in de lokale database.

2. suiteHEART® Software databaseviewer – toont de onderzoeken die zich bevinden in de actuele suiteHEART®
Software-database.

3. Aan viewer toevoegen – voegt het geselecteerde onderzoek uit de lokale database (te zien in het bovenste deel van
het venster) toe aan het suiteHEART® Software-databaseweergavegebied.

4. Uit viewer verwijderen – Verwijdert het onderzoek uit het suiteHeart® Software-databaseweergavegebied.

5. Update viewer – Sluit het venster Doorzoekbare database en brengt de onderzoeken uit het te bekijken lijstgebied
naar de applicatieviewer. Wordt gebruikt om het venster Onderzoek wisselen te vullen.

6. Annuleren – Sluit het venster Doorzoekbare database zonder veranderingen in de lijst aan te brengen.

1

2

3 4

6

5
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Procedure voor doorzoekbare DB

Onderzoeken kunnen worden bekeken door ze uit de lokale database te selecteren, toe te voegen aan de suiteHEART® 
Software-databaseviewerlijst en te klikken op Weergave bijwerken.

Voeg onderzoeken toe aan de suiteHEART® Software-lijst Onderzoek wisselen

1. Klik op Bestand > Doorzoekbare DB.

2. Zoek het onderzoek in de database-viewer en klik op het onderzoek om het te markeren.

3. Klik op Aan viewer toevoegen.

4. Klik op Update View (Beeld bijwerken).

5. Het onderzoek verschijnt nu in de suiteHEART® Software-lijst Onderzoek wisselen.

Verwijder onderzoeken uit de suiteHEART® Software-lijst Onderzoek wisselen

1. Klik op Bestand > Doorzoekbare DB.

2. Zoek het onderzoek en klik vervolgens op Verwijderen uit Viewer.

3. Klik op Update Viewer (Viewer bijwerken).

VOORZICHTIG: Wis het onderzoek niet dat momenteel is geopend in de suiteHEART® Software.

Onderzoeken moeten in suiteHeart® Software zijn geladen, voordat ze in de Viewer kunnen worden getoond. Zie ook 
“Procedure voor doorzoekbare DB” voor informatie over het vullen van de lijst Onderzoek wisselen.

Wisselen tussen studies binnen suiteHEART® Software

1. Klik op Bestand > Onderzoek wisselen.

Het venster Beschikbare onderzoeken wordt weergegeven met een lijst van alle onderzoeken die eerder waren geladen via 
de procedure voor Doorzoekbare DB.

2. Selecteer het onderzoek.

Klik als u het onderzoek niet wilt wisselen na het openen van het Switch Studies (Onderzoek wisselen) -venster buiten het 
venster om terug te keren naar de applicatie.
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Afbeeldingbeheertools

Viewer

Met de viewer kan een snelle controle van het onderzoek worden uitgevoerd met kruisverwijzing. De viewer-interface geeft de lijst 
weer van de series die zijn verkregen voor het geselecteerde onderzoek, waarbij elke serie wordt weergegeven in een kijkvenster.  
Er kunnen nieuwe serietypen worden gevormd voor analyse en controle in de viewerinterface. Door de gebruiker gedefinieerde 
weergaveprotocollen voor routinematig verkregen series kunnen ook worden aangemaakt om controle van het onderzoek te 
versnellen.

OPMERKING:  Exportfunctionaliteit kan alleen worden uitgevoerd in de suiteHEART-analysemodi. 

FIGUUR 1. Vieweroverzicht

1. Lijst van onderzoeksseries, 2. Kijkvenster voor serie/plakje, 3. Kruisverwijzing, 4. Serie opslaan, 5. Weergaveprotocollen,
6. Overschakelen naar rapporttabs, 7. Zoekfunctie, 8. Meettools

1 2

3

4
5

67 8
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Viewerfunctionaliteit

Een nieuwe serie aanmaken

Met de viewer kunnen serietypen worden gevormd die kunnen worden gebruikt voor analyse van functie, 

myocardiale evaluatie en tijdsduur of alleen voor controle (aangepast). Series die worden gemaakt, worden 
toegevoegd aan de serielijst voor dat onderzoek en zijn beschikbaar voor weergave en analyse in de 
suiteHEART® Software-applicatie.

OPMERKING:  Elk plakje uit de nieuwe serie die wordt gebruikt voor analysemodi voor Functie, Myocardiale Evaluatie 
of Tijdsduur moet hetzelfde aantal fasen hebben, hetzelfde acquisitievoorschrift hebben en parallel zijn.

WAARSCHUWING: De gebruiker is verantwoordelijk voor het maken van een nieuwe serie voor analyse die de 
juiste afbeeldingen daarvoor bevat. Onjuist samengestelde series kunnen wel worden 
geanalyseerd maar kunnen incorrecte resultaten opleveren. De gebruiker moet zijn 
gekwalificeerd in het uitvoeren van hartanalyses en op de hoogte zijn van de naar de nieuwe 
serie gekopieerde afbeeldingen van schijflocaties. Verwijder geen originele afbeeldingen die 
zijn gebruikt voor DICOM-import.

1. Selecteer de gewenste series of afbeeldingen uit de serielijst.

2. Selecteer een groep series door een Shift-klik of een Ctrl-klik uit te voeren om een enkele serie toe te voegen.

3. Door te klikken en slepen kunt u de afbeeldingen in de kijkvensters ordenen.

4. Om een afbeelding uit een kijkvenster te verwijderen, selecteert u het kijkvenster en drukt u op de Delete-toets op het
toetsenbord.

5. Selecteer  in het venster Serie opslaan Figuur 2.

FIGUUR 2. Venster Serie opslaan

6. Typ een serienaam voor de seriebeschrijving.

7. Selecteer het juiste serietype in het keuzemenu voor Functie, Myocardiale Evaluatie of Tijdsduur (Figuur 3). Als Aangepast is
geselecteerd, kunnen afbeeldingen met verschillende scanvlakken en volgordetypes als een serie worden opgeslagen.

FIGUUR 3. Nieuwe serie opslaan
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Sneltoets  

Maak een weergaveprotocol

Versnel het beoordelingsproces door een weergaveprotocol te maken waarmee een door de gebruiker 
gedefinieerde kijkvensterindeling wordt opgeslagen op basis van het serielabel.

OPMERKING:  Voor weergaveprotocollen moeten de serielabels hetzelfde zijn voor elk onderzoek. Als serielabels zijn 
gewijzigd, worden de afbeeldingen niet in het kijkvenster weergegeven. 

WAARSCHUWING: De gebruiker is verantwoordelijk voor het maken van weergaveprotocollen voor beoordeling 
die de juiste serietypen bevatten. Als de serielabels in een onderzoek worden gewijzigd, 
moet het weergaveprotocol opnieuw worden opgeslagen. Controleer altijd de serielijst om 
vast te stellen of de juiste serietypen voor beoordeling worden gebruikt.

1. Selecteer de gewenste series of afbeeldingen uit de serielijst.

2. Selecteer een groep series door een Shift-klik of een Ctrl-klik uit te voeren om een enkele serie toe te voegen.

3. Door te klikken en slepen kunt u de afbeeldingen in de kijkvensters ordenen.

4. Om een afbeelding uit een kijkvenster te verwijderen, selecteert u het kijkvenster en drukt u op de Delete-toets op het
toetsenbord.

5. Selecteer  in het weergaveprotocolpaneel.

6. Typ een labelnaam en selecteer een voorkeuzenummer in het keuzemenu (Figuur 4).

7. Klik op OK om op te slaan.

FIGUUR 4. Weergaveprotocol opslaan

Rapportageweergave-tabbladen openen

Klik op om de rapportageweergave-tabbladen te openen.

Klik op om terug te keren naar viewerfunctionaliteit.

Functie Actie

Selecteer alle afbeeldingen 
opnieuw voor weergave

Ctrl+A
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Zoekfunctie*

1. Selecteer  om de kruisverwijstool te gebruiken. 

De paarse cursor is de primaire cursor die op de afbeelding kan worden geplaatst. 

2. Bekijk automatisch alle close slice-locaties wanneer de primaire cursor is geactiveerd en gepositioneerd, druk op de
toets <Ctrl> en laat de paarse cursor los met de linkermuisknop.

De hoofdweergave wordt dan gevuld met alleen de plakken waar de secundaire groene cursor werd berekend als 
zijnde dichtbij de primaire paarse cursor. 

OPMERKING:  De groene secundaire aantekeningen verschijnen op kijkvensters met niet-parallelle afbeeldingen en op 
punten waarvan wordt berekend dat deze binnen een 3D-afstand van 10 mm van de primaire cursor 
liggen.

OPMERKING:  De groene secundaire aantekeningen verschijnen op kijkvensters met parallelle afbeeldingen en op 
punten waarvan wordt berekend dat deze binnen een 3D-afstand van 5 mm van de primaire paarse 
cursor liggen.

*Voorlopige Amerikaanse Patentaanvraag nr. 62/923.061
Titel: Methode en Systeem voor het Identificeren en Weergeven van Medische Beelden
Uitvinder(s): Wolff et al.
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Vergelijkingsmodus

De vergelijkingsmodus biedt u de mogelijkheid om afbeeldingen/series van een huidig onderzoek of van een eerder 
onderzoek tegelijkertijd binnen dezelfde interface te bekijken.

OPMERKING:  Afbeeldingen die in de vergelijkingsmodus naar een rapport worden verzonden, hebben de 
bitmapindeling. Op deze afbeeldingen zijn geen beeldmanipulaties mogelijk.

WAARSCHUWING: Controleer visueel, voorafgaand aan de beoordeling of vergelijking van onderzoeken of 
series binnen een onderzoek, alle patiëntinformatie voor beide viewers. 

FIGUUR 5. Viewer voor de vergelijkingsmodus
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Viewer 1

Viewer 2
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Viewer Uitroepen Beschrijving

Viewer 1 1 Keuzemenu series

2 Serie-selectieknop

3 Aanduidingsregel momenteel bekeken 
patiëntonderzoek

4 Beeldbediening

5 Kijkvensterlay-out-keuzes

Viewer 2 6 Aanduidingsregel momenteel bekeken 
patiëntonderzoek

7 Onderzoeksselectieknop 

8 Serie-selectieknop 

9 Kijkvensterlay-out-keuzes

Beide viewers 10 Wijzig de bereikinstellingen

11 Schakel voor beoordelingsmodus

12 Schakel voor gesynchroniseerd filmpje
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Werkstroomvoorbeeld

1. Dubbelklik op het editorvenster op een willekeurige analysemodus.

2. Selecteer  om de interface in twee viewers te splitsen, zoals weergegeven in Figuur 6.

FIGUUR 6. Bekijken in vergelijkingsmodus

3. Wijzig de serie in Viewer 1 met behulp van het keuzemenu serieselectie of de pijlen naar rechts/links.

• Deze bovenste viewer geeft altijd het huidige onderzoek weer die eerder is gestart.

4. Gebruik in Viewer 2 het keuzemenu om een andere serie te kiezen, binnen hetzelfde onderzoek, om te vergelijken
met de serie in Viewer 1.

• Wanneer in een viewer een kijkvenster is geselecteerd en het plakje parallel is, zoals een korte-asserie, wordt het
overeenkomstige plakje, op basis van de locatie van het plakje, gemarkeerd.

Viewer 1

Viewer 2
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FIGUUR 7. Seriekeuzemenu, viewer 2

5. Gebruik de onderzoekselectieknop om een ander onderzoek in Viewer 2 te vergelijken met het huidige onderzoek dat 
wordt weergegeven in Viewer 1.

FIGUUR 8. Onderzoekselectieknop, Viewer 2

6. Bevestig selectie van het juiste onderzoek door de onderzoekaanduidingsinformatie voor beide viewer te controleren.

FIGUUR 9. Onderzoekaanduidingsinformatie

7. Door met een rechtermuisknop op een van beide viewers te klikken, worden de beeldmanipulatietools geopend.

• De bereikselectie is op beide viewers van toepassing.

OPMERKING:  Het lokaliseren uitvoeren van een afbeelding vanaf het tabblad Afbeeldingen is niet geldig als de 
afbeelding uit een ander onderzoek komt. 

OPMERKING:  Als in beide viewers een cine-serie is geselecteerd en beide series hetzelfde aantal fasen hebben, klikt u 

op de  om de cine-weergaves te synchroniseren.
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Voorkeuren definiëren

Als in het Toolsmenu Preferences (Voorkeuren) vanuit de suiteHEART® Software Interface wordt geselecteerd, worden 
drie opties getoond: 

• Voorkeuren wijzigen
• Importvoorkeuren
• Exportvoorkeuren

BELANGRIJK: Aanbevolen wordt om de gebruikersvoorkeuren in te stellen voordat de eerste te rapporteren zaak 
wordt geanalyseerd. Veranderingen in voorkeuren worden pas van kracht als een nieuw onderzoek 
wordt gestart. 

Voorkeuren instellen

Met de functie Voorkeuren wijzigen kunt u rapportagefuncties aanpassen. De algemene instellingen omvatten:

• Rapportvoorkeuren
• Geautoriseerde rapportbekrachtigers
• Seriefilter
• Diversen
• Voorkeuren inactieve timer
• Exportvoorkeuren

Door de gebruiker gedefinieerde resultaatparameterbereiken kunnen worden gemaakt op het tabblad 
Sjabloonvoorkeuren. Macro's voor gestructureerde rapportage kunnen worden gemaakt op het tabblad Macro-
voorkeuren.

Globale instellingen

Rapportvoorkeuren

Configureert de headerinformatie die in alle rapporten verschijnt.
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FIGUUR 1. Tab rapportlay-out

Procedure rapportvoorkeuren 

1. Selecteer vanuit de beeldviewmenubalk Tools > Preferences (Voorkeuren) > Edit Preferences (Voorkeuren wijzigen).

2. Selecteer het tabblad Algemene instellingen.

3. Zet de cursor in het gewenste veld van het paneel Report Preferences (Rapportvoorkeuren) en voer informatie in.

Titels, kopjes en logo komen in een rapport op het gespecificeerde papierformaat. Deselecteer om deze 
informatie uit het rapport te laten het vakje „Gebruik de onderstaande veldwaarden in rapport”. Vervolgens 
geldt dit voor alle patiëntrapporten die worden afgedrukt. 

Als u „ondersteuning voor even en oneven rij” aanvinkt, worden de resultaatrijen in het rapport gemarkeerd.

4. Geef om een sitelogo in het rapport op te nemen het bestand een .jpeg, .png, of .gif-formaat en sla het op op de harde 
schijf of een cd-rom. Selecteer Browse (Browsen) in het Logovakje en zoek het bestand in het
systeembrowservenster. Selecteer het geschikte logobestand en selecteer Open (Openen).

Het logo zou nu moeten verschijnen in het rapportvoorkeurenpaneel.

5. Klik met de rechtermuisknop op de Naam examenbestand om de bestandsnaam van het exportbestand te
configureren (alleen voor goedgekeurde examens).
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6. Selecteer Save and Exit (Opslaan en verlaten) om uw toevoegingen te bewaren en sluit Wijzig Voorkeuren.

• Selecteer Cancel (Annuleren) om het venster te verlaten zonder veranderingen te accepteren.
• Selecteer Reset (Resetten) om alle waarden op de tab Algemene instellingen te resetten zonder het venster te verlaten.

Geautoriseerde Rapportbekrachtigers

De applicatie heeft een functie om rapporten goed te keuren, waarmee het uiteindelijke rapport wordt afgesloten. 
Eenmaal afgesloten, kan het rapport niet meer worden aangepast. De referenties van de bekrachtigers worden 
toegevoegd, aangepast en verwijderd zoals beschreven.

FIGUUR 2. Geautoriseerde rapportbekrachtigers

Beheren Procedure rapportbekrachtiging

1. Selecteer vanuit de beeldviewmenubalk Tools > Preferences (Voorkeuren) > Edit Preferences (Voorkeuren wijzigen).

2. Selecteer de tab Globale instellingen en zet de cursor in het paneel Authorized Report Approvers (Geautoriseerde
rapportbekrachtigers) .

3. Selecteer de tab Add (Toevoegen) om een gebruikersnaam toe te voegen aan een lijst van geautoriseerde
bekrachtigers.

• Voer de gebruikersnaam in.
• Voer het wachtwoord tweemaal in.
• Selecteer Add (Toevoegen).

4. Selecteer de tab Modify (Bewerken) om het wachtwoord te veranderen van een gebruiker op de lijst van
geautoriseerde bekrachtigers.

• Selecteer de te wijzigen gebruiker.
• Voer het oude wachtwoord in.
• Voer het nieuwe wachtwoord tweemaal in.
• Selecteer Toepassen.

5. Selecteer de tab Delete (Verwijderen) om een gebruiker te verwijderen uit de lijst van geautoriseerde bekrachtigers.

• Selecteer de te verwijderen gebruiker(s).
• Selecteer Delete (Verwijderen).



suiteHEART® Software-gebruiksaanwijzing NS-03-040-0008 Versie�1      32

Seriefilter

Op basis van typen analysemodi kan een seriefilter worden toegepast om de selectie van de juiste serie voor analyse te 
versnellen. De filtervoorkeuren kunnen ook tijdens de analyse worden geselecteerd door te klikken op de filterknop in het 
hoofdvenster, boven de miniatuurweergave. 

FIGUUR 3. Filtervoorkeuren

Selecteer Filtervoorkeur

1. Selecteer vanuit de beeldviewmenubalk Tools > Preferences (Voorkeuren) > Edit Preferences (Voorkeuren wijzigen).

2. Selecteer het tabblad Algemene instellingen.

3. Klik op de juiste aan/uit-selectie voor elk analysetype.

4. Selecteer Save and Exit (Opslaan en verlaten) om uw toevoegingen te bewaren en sluit Wijzig Voorkeuren.

• Selecteer Cancel (Annuleren) om het venster te verlaten zonder veranderingen te accepteren.
• Selecteer Reset (Resetten) om alle waarden op de tab Algemene instellingen te resetten zonder het venster te verlaten.

OPMERKING:  Als een seriefilter is toegepast en de vereiste serie niet aanwezig is, verschijnt een bericht: „Er zijn geen 
series gekoppeld aan het geselecteerde analysetype.” Als u op OK klikt, wordt het filter uitgeschakeld en 
worden alle reeksen in het onderzoek weergegeven.
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Diversen

FIGUUR 4. Diversenpaneel

Procedure voor het wijzigen van diversenparameters 

1. Selecteer vanuit de beeldviewmenubalk Tools > Preferences (Voorkeuren) > Edit Preferences (Voorkeuren wijzigen).

2. Selecteer de tab Globale instellingen en zet de cursor in het paneel Miscellaneous (Diversen).

3. Vink het vakje aan naast Anonymize Patient (Patiënt anoniem maken) om de patiëntnaam en -ID-nummers in het
rapport te verbergen.

Alle patiëntnamen zullen worden aangeduid met „anoniem” en het ID is blanco. Deze veranderingen gelden voor 
het rapport en de beeldviewer.

4. Inschakelen tabletmodus om de toepassing op een tablet te draaien.

5. Vink het selectievakje Automatische Basislijncorrectie inschakelen aan om automatisch de automatische
fasefoutcorrectie uit te voeren voor 2D- en 4D-fasecontrast.

6. Schakel het selectievakje Annotatie dikke lijn weergeven in om annotaties als dikke lijnen weer te geven.

7. Schakel het selectievakje Bewerken met nudge-tool in om de bewerkingstool in te schakelen voor alle analysesessies.

8. Controleer de Disable Button Tooltips om tooltips te verbergen.

9. Selecteer Enable LV of RV Shadow Curve om beide curven weer te geven.

10. Vink Actieve ROI bewerken voor geen overlap aan om overlapping uit te schakelen.

Wanneer „Actieve ROI bewerken voor geen overlap” is aangevinkt, zijn de ROI's die momenteel niet zijn geselecteerd 
dominant en wanneer dit is uitgeschakeld, is de ROI die wordt bewerkt dominant.



suiteHEART® Software-gebruiksaanwijzing NS-03-040-0008 Versie�1      34

11. Vink Flip x (segment) en y (fase) as aan voor matrixmodus om de as te verwisselen.

12. Voor automatische plaatsing van de basale lijn voor functieanalyse vinkt u Automatic MV of TV Annulus Line Insertion.

13. Schakel Persist-analysehulpmiddelen voor Functie Auto in voor het uitvoeren van bewerkingen bij het gebruik van
Auto Segmentation.

14. Klik op Onderzoek openen met Virtual Fellow om de casus rechtstreeks te openen met Virtual Fellow™.

15. Selecteer Nieuwste, Oudste en Vragen voor de Siemens Auto Combine Mode in het vervolgkeuzemenu voor bestanden. 

OPMERKING:  Als het serielabel „null” is, wordt de serie genegeerd.

16. Selecteer Verzadigingsherstel of MOLLI in het vervolgkeuzemenu T1-Mapping reekstype.

17. Selecteer Save and Exit (Opslaan en verlaten) om uw toevoegingen te bewaren en sluit Wijzig Voorkeuren.

• Selecteer Cancel (Annuleren) om het venster te verlaten zonder veranderingen te accepteren.
• Selecteer Reset (Resetten) om alle waarden op de tab Algemene instellingen te resetten zonder het venster te verlaten.

Voorkeuren inactieve timer

Het paneel Voorkeuren inactieve timer stelt het tijdsinterval in minuten in waarna de toepassing na een ingestelde periode van 
inactiviteit wordt gesloten. 

FIGUUR 5. Venster Voorkeuren inactieve timer

Procedure voor het wijzigen van de Inactieve timer

1. Selecteer vanuit de beeldviewmenubalk Tools > Preferences (Voorkeuren) > Edit Preferences (Voorkeuren wijzigen).

2. Selecteer de tab Globale instellingen en zet de cursor in het paneel Voorkeuren Inactieve timer.

3. Vink om de functie Inactieve timer te activeren het vakje Inactieve timer aan.

4. Sleep de intervalmarker voor Inactieve timer naar de gewenste tijd in minuten.

5. Selecteer Save and Exit (Opslaan en verlaten) om uw toevoegingen te bewaren en sluit Wijzig Voorkeuren.

• Selecteer Cancel (Annuleren) om het venster te verlaten zonder veranderingen te accepteren.
• Selecteer Reset (Resetten) om alle waarden op de tab Algemene instellingen te resetten zonder het venster te verlaten.
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Exportvoorkeuren

Met het Exportvoorkeurenpaneel kunt u de beeldformaten selecteren om afbeeldings- en videogegevens te exporteren. 
Met de exportfunctie kunt u niet-gecomprimeerde .avi-films, gecomprimeerde QuickTimefilms, .GIF, .JPEG, .TIFF en .PNG-
bestanden van de afbeeldingsgegevens maken.

FIGUUR 6. Exportvoorkeurenvenster

Procedure exportvoorkeuren 

1. Selecteer vanuit de beeldviewmenubalk Tools > Preferences (Voorkeuren) > Edit Preferences (Voorkeuren wijzigen).

2. Selecteer de tab Globale instellingen en zet de cursor in het paneel Export Preferences (Exportvoorkeuren).

3. Selecteer de juiste afbeeldingsgegevenssoorten.

4. Selecteer Save and Exit (Opslaan en verlaten) om uw toevoegingen te bewaren en sluit Wijzig Voorkeuren.

• Selecteer Cancel (Annuleren) om het venster te verlaten zonder veranderingen te accepteren.
• Selecteer Reset (Resetten) om alle waarden op de tab Algemene instellingen te resetten zonder het venster te verlaten.

Sjabloonvoorkeuren

De applicatie biedt een hulpmiddel om door de gebruiker gedefinieerde sjablonen te maken op basis van leeftijd, BSA en 
gewicht die een gestructureerde workflow bieden voor het meten en rapporteren van specifieke kwantitatieve parameters.

FIGUUR 7. Tabblad Sjabloonvoorkeuren

Overwegingen

Voordat u de analyse start, moet de door de gebruiker gedefinieerde sjabloon worden geselecteerd in de hoofdinterface. 
Klik rechtsboven op de knop Standaard en selecteer de sjabloon die moet worden gebruikt. Als u de sjabloon wijzigt na 
het uitvoeren van de analyse, wordt het voorkeursbereik toegepast dat in de sjabloon wordt toegepast.
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OPMERKING:  Geïmporteerde onderzoeken met eerdere suite HEART-analyse kunnen de naam weergeven van de 
sjabloon die voor dat onderzoek is gebruikt. Die sjabloon is mogelijk niet beschikbaar in de huidige 
software.

Het wordt aanbevolen dat als twee systemen worden gebruikt voor analyse, het sjabloonvoorkeurenbestand op het eerste 
systeem wordt gemaakt en vervolgens in het tweede systeem wordt geïmporteerd. Sjabloonvoorkeurbestanden die zijn 
geïmporteerd vanuit een ander systeem, overschrijven de sjabloonvoorkeuren als ze al op dat systeem zijn gemaakt.

FIGUUR 8. Sjabloon veranderen

Procedure voor het maken van sjablonen

Nu volgt een richtlijn voor het maken van een door gebruiker gedefinieerde sjabloon. Het is aan het oordeel van de arts 
om de geldigheid van het gebruikte parameterbereik te verifiëren.

Een sjabloon maken

Alle nieuwe sjablonen worden aangemaakt door het dupliceren van een al bestaande sjabloon. De standaardsjabloon zal 
worden gebruikt in het voorbeeld, aangezien hij bij het product wordt geleverd en altijd beschikbaar is. De standaardsjabloon 
kan niet worden bewerkt. Ga als volgt te werk om een door de gebruiker gedefinieerde sjabloon te maken: 

1. Selecteer Tools > Preferences (Voorkeuren) > Voorkeuren bewerken.

2. Selecteer de tab Template Preferences (Sjabloonvoorkeuren).

3. Klik op de Nieuwe aanmaken-knop.

4. Selecteer het voorkeursbereik van leeftijd, BSA of gewicht.

FIGUUR 9. Venster Sjabloon veranderen

5. Type een nieuwe naam voor de sjabloon.

Wanneer een nieuwe naam wordt ingevoerd, wordt het vervolgmenu De huidige sjabloon is bijgewerkt.

6. Voer bereikvoorkeuren in voor de gewenste parameters.

7. Selecteer Save and Exit (Opslaan en verlaten).

- Selecteer Cancel (Annuleren) om het venster te verlaten zonder veranderingen op te slaan.
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Dubbel Sjabloon

1. Selecteer Tools > Preferences (Voorkeuren) > Voorkeuren bewerken.

2. Selecteer de tab Template Preferences (Sjabloonvoorkeuren).

3. Selecteer de sjabloon uit Het Huidige sjabloon is-keuzemenu.

4. Klik op de knop Dupliceren.

Een sjabloon verwijderen

1. Selecteer Tools > Preferences (Voorkeuren) > Voorkeuren bewerken.

2. Selecteer de tab Template Preferences (Sjabloonvoorkeuren).

3. Selecteer de sjabloon uit Het Huidige sjabloon is-keuzemenu.

4. Klik op de knop Verwijderen.

Bewerk de voorkeursbereiken

1. Selecteer Tools > Preferences (Voorkeuren) > Voorkeuren bewerken.

2. Selecteer de tab Template Preferences (Sjabloonvoorkeuren).

3. Selecteer een andere sjabloon dan de standaard.

FIGUUR 10. Sjabloonvoorkeuren

1. Huidige sjabloon, 2. Categorieselectie, 3. Parametermetingen per analyse, 4. Mannelijke boven- en ondergrenzen,
5. Vrouwelijke boven- en ondergrenzen, 6. Bereikbalk.

1
2

3

4 5

6
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4. Selecteer de gewenste sjablooncategorie. Selecties zijn Leeftijd, BSA en Gewicht.

OPMERKING:  De geselecteerde sjabloon wordt op de sessie toegepast.

5. Klik met de linkermuisknop op de bereikbalk om te activeren.

De balk wordt groen wanneer deze actief is.

6. Klik met de rechtermuistoets op de bereikbalk om een scheiding te maken in het midden van de bereikbalk.

• De balken om het bereik te splitsen kunnen worden verschoven om de locatie te wijzigen.
• Er kunnen meerdere balken worden aangemaakt.
• De balken kunnen worden verwijderd door de cursor dicht bij de balk te plaatsen en Delete Range (Verwijder bereik) te

selecteren in het rechtermuistoetsmenu.

7. Voer de parameterbereikwaarden in voor de juiste analysemodus. Voer zowel de onder- als bovengrenzen in. Maak
waar nodig onderscheid tussen waarden voor mannen en vrouwen. Kopieer met de Copy All (Alles kopiëren) -pijltjes
waarden tussen de geslachten. Navigeer met de schuifbalk naar de metingen voor alle analysewijzen.

WAARSCHUWING: Waarden die worden ingevoerd voor parameterbereiken zijn de exclusieve 
verantwoordelijkheid van de gebruiker. Bevestig alle parameterbereiken voorafgaand aan 
analyse. Onjuiste parameterwaarden kunnen leiden tot een verkeerde diagnose.

8. Selecteer Save and Exit (Opslaan en verlaten) om uw toevoegingen te bewaren en sluit Voorkeuren.

• Selecteer Cancel (Annuleren) om het venster te verlaten zonder veranderingen te accepteren.

OPMERKING:  Om een sjabloon geldig te laten zijn, moeten parameterwaarden worden ingevoerd als numerieke 
getallen met zowel de bovenste als de onderste waarde ingevoerd. Als er inconsistenties in de waarden 
worden gevonden, verschijnt het volgende bericht: „Ongeldig normaal bereik geselecteerd. Corrigeer 
dit en sla het opnieuw op.” De parameter die moet worden gecorrigeerd, wordt rood gemarkeerd.  
Het opslaan van een blanco sjabloon is niet toegestaan en zorgt ervoor dat het volgende bericht „Kan 
sjabloon(en) niet opslaan” wordt weergegeven.

OPMERKING:  Waarden die zijn ingevoerd voor Stroom beïnvloeden zowel de 2D- als 4D-stroomanalyseresultaten.

OPMERKING:  Zie Bijlage A voor meer informatie.

Macrovoorkeuren

Macro's kunnen de tijd voor het rapporteren van een MRI-onderzoek significant inkorten. Alle macro's zijn onafhankelijk 
van sjablonen. De gestroomlijnde gebruikersinterface van de macro’s laat taken geautomatiseerd verrichten, waaronder 
de volgende:

• Het aanmaken van vooraf gedefinieerde klinische indrukken en technieken die automatisch kunnen worden ingevoegd.
• Het automatisch invoegen van kwantitatieve resultaten uit de analyserapportvensters.

Een Indrukkenmacro toevoegen

OPMERKING:  Het maken van een Geschiedenis- of techniekmacro volgt dezelfde workflow als van een Indrukkenmacro.

1. Selecteer Tools > Preferences (Voorkeuren) > Voorkeuren bewerken.

2. Selecteer de tab Macro Preferences (Macrovoorkeuren).

3. Selecteer Add Impressions Macro (Indrukkenmacro toevoegen). In het paneel Indrukkenmacro verschijnt een
nieuwe toets.
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FIGUUR 11. Indrukkenmacrovenster

4. Plaats de cursor in het nieuwe knopveld en bewerk de naam naar wens.

OPMERKING:  De gemaakte macrotoetsen kunnen opnieuw worden gerangschikt. Klik en sleep de gewenste knop naar
een nieuwe positie in de lijst.

De macrotekst invoeren

1. Zet de cursor in het tekstveld Macro-informatie en voer relevante tekst in.

2. Selecteer om een berekening in te voeren een van de analysetabs hieronder en selecteer de gewenste
parametertoets, die automatisch in de macro-informatie zal worden ingevoerd. In dit voorbeeld werd de parameter
LV-uitstootfractie geselecteerd en aan het eind van de tekst ingevoerd.

FIGUUR 12. Macro-informatie

FIGUUR 13. Macro-informatievenster 

3. Selecteer Save and Exit (Opslaan en verlaten) om uw veranderingen op te slaan in de nieuwe macro en de macro-
editor te verlaten.

• Selecteer Cancel (Annuleren) om de macro-editor te verlaten zonder veranderingen op te slaan.

Een macro uitvoeren

Als een voorwaarde voor macro-uitvoering, moeten analyseresultaten worden aangemaakt voordat macro's die 
numerieke berekeningen omvatten, worden uitgevoerd. Techniek- en vertoningsmacro's kunnen worden gemaakt om het 
genereren van rapporten te automatiseren.
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Een macro verwijderen

1. Selecteer Tools > Preferences (Voorkeuren) > Voorkeuren bewerken.

2. Selecteer de tab Macro Preferences (Macrovoorkeuren).

3. Selecteer de macro uit de lijst.

In het getoonde voorbeeld, is de macro genaamd MACRO_3 geselecteerd om te worden verwijderd.

FIGUUR 14. Macroselectielijst

4. Selecteer Remove Selected Macro(s) (Geselecteerde macro('s) verwijderen).
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Afdrukvoorkeuren

Berekende resultaten uit elke analysemodus kunnen worden geconfigureerd voor opname in het rapport op het tabblad 
Afdrukvoorkeuren.

FIGUUR 15. Afdrukvoorkeurenvenster

1. Selecteer vanuit het beeldviewmenu Tools > Preferences (Voorkeuren) > Print Preferences (Voorkeuren afdrukken).

2. Selecteer het juiste analysetabblad en vink het gewenste resultaat aan dat in het rapport moet worden opgenomen.

3. Herhaal dit voor elk tabblad van de analysemodus.

4. Selecteer „Save and Exit (Opslaan en verlaten).”

OPMERKING:  Als afdrukselecties rechtstreeks in de toepassingsinterface worden gemaakt, worden deze niet met de
sjabloon opgeslagen.
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Importvoorkeuren

Sjablonen kunnen uit het bestandssysteem worden geïmporteerd. 

Procedure importvoorkeuren

1. Selecteer Tools > Preferences (Voorkeuren) > Import Preferences (Importvoorkeuren).

FIGUUR 16. Importvoorkeurenvenster

2. Selecteer de knop Bladeren, selecteer de locatie van het voorkeursbestand en selecteer vervolgens de knop Openen.

3. Als u weergaveprotocollen wilt importeren, selecteert u het keuzerondje voor Only Viewing Protocols (Alleen
weergaveprotocollen).

4. Selecteer OK om de gedefinieerde exportprocedure uit te voeren.

• Selecteer Cancel (Annuleren) om het venster te verlaten zonder de sjabloon te exporteren

OPMERKING:  Het importeren van voorkeuren uit eerdere versies (4.0.4 of lager) van suiteHEART® Software wordt niet 
ondersteund. Neem contact op met NeoSoft Support op service@neosoftmedical.com voor hulp bij het 
importeren van voorkeuren uit eerdere versies.

Exportvoorkeuren
Sjablonen kunnen naar het bestandssysteem worden geëxporteerd.

Procedure exportvoorkeuren

1. Selecteer Tools > Preferences (Voorkeuren) > Export Preferences (Exportvoorkeuren).

FIGUUR 17. Exportvoorkeurenvenster

2. Selecteer Browse (Bladeren), selecteer de map waarin u het voorkeursbestand wilt plaatsen en selecteer vervolgens
Save (Opslaan).

3. Selecteer OK om de exportprocedure uit te voeren zoals omschreven.

• Selecteer Cancel (Annuleren) om het venster te sluiten zonder de sjabloon te exporteren.
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Virtual Fellow™

Virtual Fellow™ is een gestandaardiseerde functie voor het bekijken van afbeeldingen voor cardiale MR-onderzoeken.  
De functie verbetert de visualisatiewerkstroom waardoor het voor clinici gemakkelijker wordt om cardiale MR-onderzoeken te 
beoordelen. De functie past automatisch beeldmanipulatietools toe zoals vensterniveau, zoomen, pannen en roteren. Huidige 
en eerdere cardiale MR-onderzoeken kunnen eenvoudig worden beoordeeld met de functie Virtual Fellow™.

OPMERKING:  Om de functie Virtual Fellow™ bij voorbewerken in te schakelen, raadpleeg de suiteDXT-
Gebruikshandleiding NS-03-040-0014.

OPMERKING:  De patiënt-ID moet overeenkomen om zowel het huidige als het eerdere onderzoek te kunnen bekijken 
in Virtual Fellow™. 

OPMERKING:  Het bewerken van analyseresultaten kan niet worden uitgevoerd in Virtual Fellow™, selecteer de juiste 
analysemodus om bewerkingen uit te voeren. 

WAARSCHUWING: De gebruiker is verantwoordelijk voor het controleren van de juiste beeldselectie voor de 
weergaveprotocollen die door de Virtual Fellow™ zijn gegenereerd. Afbeeldingen die onjuist 
zijn aangewezen voor huidige/eerdere weergaveprotocollen kunnen handmatig worden 
geselecteerd. De gebruiker moet goed worden getraind in cardiale beeldvormingstechnieken 
om ervoor te zorgen dat de juiste afbeeldingen worden beoordeeld. Gebruik de Viewer-
modus in Afbeeldingbeheertools op pagina 21 om alle afbeeldingen te bekijken die voor het 
onderzoek zijn verkregen.

WAARSCHUWING: Controleer, voorafgaand aan de beoordeling of vergelijking van onderzoeken, visueel alle 
informatie ter aanduiding van de te onderzoeken patiënt bovenaan de interface. # 1 geeft 
het huidige onderzoek aan, # 2 geeft het eerdere onderzoek aan.

WAARSCHUWING: Beeldmanipulatie zoals WW/WL, pannen, zoomen, roteren en omdraaien uitgevoerd door 
Virtual Fellow™ kan de verschijningsvorm van verschillende ziektebeelden en het 
onderscheiden van andere anatomische structuren beïnvloeden. Beoordeel elk 
weergaveprotocol en voer de relevante aanpassingen uit.
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Voorbewerking met Virtual Fellow™

Serieaanduiding

Automatische segmentatie
(van aangegeven series)

Automatische detectie van klepannulus
(indien ingeschakeld)

Virtual Fellow™ - Weergaveoptimalisatie
(indien ingeschakeld)

Compleet
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Virtual Fellow™-interface

Virtual Fellow™-interfacefuncties

Selectie Beschrijving

Virtual Fellow™

Toon functieresultaten

Toon stroomresultaten

Toon resultaten van myocardiale evaluatie

Lange-as kruisverwijzing

& Resultaatweergave

Hoofd-viewer

Beeldweergavebesturing

Bekijken
Protocollen
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Link Toggle wordt gebruikt om WW/WL uit te 
voeren, pannen, roteren en omdraaien op zowel 
de huidige als de vorige serie.

Unlink Toggle wordt gebruikt om WW/WL uit te 
voeren, pannen, roteren en omdraaien op een 
enkele serie.
Opmerking: Zoom wordt altijd toegepast op 
zowel huidige als eerdere series.

Fase wordt gebruikt om fasegevoelige late 
aankleuring te bekijken.

Sterkte wordt gebruikt om de sterkte van late 
aankleuring te bekijken.

MOCO wordt gebruikt om bewegingscorrectie 
in de tijdsduurserie te bekijken.

NO MOCO wordt gebruikt om tijdsduurseries 
te bekijken zonder bewegingscorrectie.

#1 is de indicator voor de serie die wordt 
weergegeven voor het huidige onderzoek. Klik 
met de linkermuisknop rechtstreeks op #1 om 
de serie te wijzigen. 

#2 is de indicator voor de serie die wordt 
weergegeven voor de vorige onderzoeksserie. 
Klik met de linkermuisknop rechtstreeks op #2 
om de serie te wijzigen.

Cine-bedieningselementen worden gebruikt 
om af te spelen, te pauzeren, de frames per 
seconde te selecteren en de begin- en 
eindframes van de film te definiëren.

Referentietool om beelden met dezelfde 
locatie automatisch te identificeren en weer te 
geven. Raadpleeg Zoekfunctie* op pagina 24 
voor informatie over het gebruik van deze 
functie.

Meetinstrumenten.

Selectie Beschrijving
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Protocollen bekijken

Generieke meetbewerkingen ongedaan 
maken.

Kijkvensterlayout-opties*: 1x1, 1x2, 4x4 en 5x4.
*Afhankelijk van geselecteerd protocol.

Toepassingsgebied heeft dezelfde functie als 
beschreven in Beeldmanipulatietools op 
pagina 12.

Toetsenbordpijltje links Wordt gebruikt om de plaklocatie vooruit te 
zetten in een huidig/eerder 
weergaveprotocol.

Toetsenbordpijltje rechts Wordt gebruikt om de plaklocatie achteruit te 
zetten in een huidig/eerder 
weergaveprotocol.

Serietype

Korte-as cine-functieserie.

Huidige korte-as cine-functie met vorige.

Myocardevaluatie.

Huidige Myocardiale Evaluatie met prior.

Korte-as cine-functie met Myocardiale Evaluatie.

Tijdsduurserie Stress.

Selectie Beschrijving
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Sneltoetsen

Huidige Tijdsduurserie met prior.

Huidig Tijdsverloop Stress met Myocardiale Evaluatie.

Tijdsverloop Stress/Rust serie.

T1-axiale serie.

SSFP met T1-axiale serie.

Functie Toetsenbordactie

Blader vooruit op lange as-weergaven als de gele hoekindicator 
aanwezig is.

Z

Blader achteruit op lange as-weergaven als de gele 
hoekindicator aanwezig is.

A

Serietype
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Gebruikersselectie van een serie voor weergaveprotocollen

Weergaveprotocollen zijn geconfigureerd om afbeeldingen van het huidige onderzoek of van het huidige en eerder 
onderzoek te bekijken. Als de weergegeven afbeeldingen niet de verwachte te beoordelen afbeeldingen zijn, selecteert u 
de juiste serie opnieuw door met de linkermuisknop te klikken direct boven de getalnotatie (#1 voor huidig onderzoek of 
#2 voor eerder onderzoek) op de Virtual Fellow™-interface zoals weergegeven in Figuur 1. De serielijst voor het huidige 
onderzoek (#1) wordt weergegeven, selecteer de juiste serie. 

FIGUUR 1. Virtual Fellow-interface
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Gebruikersselectie van een serie voor lange as-kruisverwijzingskijkvenster

Als de weergegeven afbeeldingen niet de verwachte weergaven zijn, kunt u de juiste serie selecteren door direct op een 
lange as-kijkvenster te klikken en vervolgens de afbeelding in het vervolgkeuzemenu voor bestanden te selecteren, zoals 
weergegeven in onderstaande Figuur.

OPMERKING:  Als de toetsenbordselecties van Z of A worden gebruikt, is de door de gebruiker geselecteerde 
afbeelding niet langer aanwezig in het kijkvenster.

Voorkeur voor apicale richting van de lange as voor Virtual Fellow™

1. Selecteer vanuit de beeldviewmenubalk Tools > Preferences (Voorkeuren) > Edit Preferences (Voorkeuren wijzigen).

2. Selecteer het tabblad Virtual Fellow™.

3. Selecteer de gewenste apicale richting voor de lange-asweergaven, zoals hieronder getoond.

FIGUUR 2. Voorkeur voor apicale richting van de lange as
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Contouren wijzigen

Contouren wijzigen, zoals beschreven in dit onderdeel, is beschikbaar in alle analysemodi. Deze functie is beschikbaar in 
zowel het Editor-venster als in de Review-modus.

Contourwijzigingsopties

Conventionele bewerking

1. Klik in het Editor-venster met de linkermuisknop op de contour. Als de contour wordt geselecteerd, wordt hij paars.

2. Klik met de linkermuisknop en sleep in het midden van de contour om deze te verplaatsen, zoals weergegeven in
Figuur 1.

• Als de geselecteerde contour is gemaakt met behulp van de punt-splinemethode, worden de punten tijdens het
wijzigingsproces getoond. Klik met de linkermuisknop en sleep een van de punten om de omvang en vorm van de contour
te wijzigen zoals getoond in Figuur 1.

• Als de geselecteerde contour is gemaakt met behulp van de traceerfunctie uit de vrije hand, houdt u de linkermuisknop
ingedrukt om de contour bij te werken.

FIGUUR 1. Conventionele contourbewerking
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Nudgefunctie 

1. Klik met de linkermuisknop op de contour om de nudge-functie te activeren. Klik vervolgens met de rechtermuisknop
en selecteer de nudge-functie in het pop-upmenu, zoals weergegeven in Figuur 2.

• Wanneer de nudge-functie wordt toegepast, wordt de geselecteerde puntwervel-ROI automatisch een ROI uit de vrije hand.

FIGUUR 2. Activatie van nudge-functie

2. De cursor verschijnt als een vierkant. Plaats de cursor weg van de ROI en houd de linkermuisknop ingedrukt.
De nudge-functie verschijnt, zoals getoond in Figuur 3.

OPMERKING:  De grootte van de nudge-cirkel is standaard de grootte die een gelijke afstand is van het muispunt tot de 
geselecteerde ROI. Verplaats de cursor om de grootte te wijzigen.

FIGUUR 3. Nudge-functie
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3. Als u de nudge-functie wilt deactiveren, klikt u met de linkermuisknop op de contour en klikt u vervolgens met de
rechtermuisknop en selecteert u de nudge-functie in het pop-upmenu, zoals weergegeven in Figuur 4.

FIGUUR 4. Nudge-functie deactivering

OPMERKING:  De standaard aan/uit-status van de nudge-functie kan worden ingesteld in Voorkeuren.

Een contour verwijderen

1. Klik met de linkermuisknop op de contour om deze te selecteren en druk op de delete-toets op het toetsenbord.

Of

2. Klik met de linkermuisknop op de contour om deze te selecteren, klik vervolgens met de rechtermuisknop en kies de
prullenbak in het pop-upmenu, zoals weergegeven in Figuur 5.

FIGUUR 5. Contour verwijderen
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Functieanalyse
De gebruiker is verantwoordelijk voor de juiste en volledige plaatsing (en correcte toewijzing) van alle interessegebieden (ROI's), 
inclusief de gebieden die zijn gegenereerd of aangepast door de automatische segmentatiealgoritmen. De kwantitatieve waarden 
die door de software worden gegenereerd, zijn afhankelijk van de juiste en volledige plaatsing (en correcte toewijzing) van deze 
interessegebieden.

De functie voorverwerken van het onderzoek maakt de voorverwerking van functieanalyse mogelijk. Raadpleeg de 
gebruiksaanwijzing van suiteDXT NS-03-040-0014.

Deze paragraaf beschrijft de stappen die benodigd zijn voor een hartfunctieanalyse. De voorbeelden geven een overzicht 
van de in de applicatie toegepaste stappen om een hartfunctieanalyse uit te voeren. De procedures beschrijven hoe een 
kwantitatieve analyse moet worden uitgevoerd.

BELANGRIJK: Aanbevolen wordt om de hartanalyse te laten uitvoeren door gekwalificeerd personeel, als de 
analyseresultaten moeten worden gebruikt om een diagnose te stellen.

WAARSCHUWING: De applicatie helpt alleen bij de analyse van de afbeeldingen en levert niet automatisch 
kwantificeerbare resultaten op. Het gebruiken en plaatsen van kwantitatieve metingen is 
aan de gebruiker. Onnauwkeurige metingen kunnen leiden tot verkeerde diagnoses. 
Metingen dienen alleen te worden verricht door goed opgeleid en gekwalificeerd personeel.

WAARSCHUWING: Een onjuist scanvlak kan leiden tot verkeerde analyseresultaten. Zie Bijlage B.

OPMERKING:  Bij retrospectieve 2D-series gemaakt op basis van 4D Flow is mogelijk handmatige segmentatie vereist.

Er zijn drie categorieën voor analyse:

- omvat volumeanalyse voor de linker ventrikel (LV) en rechter ventrikel (RV)

- omvat volumeanalyse voor het linker atrium (LA) en rechter atrium (RA).

- Omvat vooraf gedefinieerde lineaire metingen en door de gebruiker gedefinieerde metingen die kunnen
worden toegevoegd.
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 Ventrikels
Selecteer de analysewijze:

 Klik op  om contouren te wissen.

OPMERKING:  De matrixmodus kan worden gebruikt voor het wissen van contouren.

Indexmetingen berekenen

1. Selecteer het tabblad Geschiedenis.

2. Voer lengte en gewicht van de patiënt in.

De eind-diastolische volume-index, eind-systolische volume-index, eind-diastolische massa-index, eind-
systolische massa-index, massa-indexfase, cardiale outputindex en beroerte volume-indexmetingen worden 
berekend op de meettabel.

OPMERKING:  De BSA-berekeningsmethode kan worden geselecteerd op het tabblad Geschiedenis in de rapportweergave.

Automatische LV- & RV-segmentatie

De automatische segmentatiefunctie berekent standaardparameters van de hartfunctie zonder anatomische invoer. 
Nadat segmentatieresultaten zijn gegenereerd, kunnen soorten ROI worden geselecteerd of gedeselecteerd om te 
bekijken. Segmentatiebewerking kan ook worden uitgevoerd op basis van gebruikersinvoer. 

OPMERKING:  Als de knoppen LV en RV in Functie Korte as beide zijn uitgeschakeld of als de knop voor kamerkeuze in 
Lange as is uitgeschakeld, wordt de knop Start Automatisch Propageren uitgeschakeld. 

Voer de volgende handelingen uit om LV- & RV- segmentatie te starten: 

1. Selecteer de korte-asserie en wijzig het venster/niveau.

2. Klik op .

3. Klik op  voor automatische segmentatie.

4. Maak de relevante selecties op de segmentatiewerkbalk, zoals weergegeven in Figuur 1.

5. Selecteer  om automatische segmentatie te starten.

Korte as Lange as
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FIGUUR 1. Segmentatiewerkbalk

*De propagatiefunctionaliteit zal worden gewisseld wanneer de voorkeur wordt aangevinkt voor x-as (plakje) en y-as
(fase) omdraaien voor matrixmodus.

Tabel 1:  Automatische segmentatie contourtypes

Gladde modus – 
inclusief de papillaire 
spieren in het 
ventriculaire volume. 

Papillaire modus – 
exclusief de papillaire 
spieren uit van het 
ventriculaire volume. 

Endocardiale en 
epicardiale 
contouren tonen. 

Endocardiale 
contouren tonen.

Toon contouren.

Tabel 2:  Automatische segmentatie propageertypes

Verspreid alle plakjes 
gedurende alle fasen of 
toon alle plakjes 
gedurende alle fasen

Propageer alle plakjes; 
enkele fase

Propageer alle fasen; 
enkel plakje

Toon alleen contouren 
voor ED/ES-fasen tijdens 
propagatie

Tabel 3:  Ventriculaire selectie

Linker ventrikel - Genereer segmentatie of weergave Rechter ventrikel - Genereer segmentatie of weergave
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Voer automatische segmentatie uit voor alle plakjes en alle fasen

Deze optie is vereist voor het genereren van resultaten van regionale analyse, dyssynchronie en klepvlakanalyse. 

1. Selecteer de korte-asserie en wijzig het venster/niveau.

2. Klik op .

3. Klik op  voor automatische segmentatie.

4. Selecteer in de segmentatiebalk een gladde  of papillaire modus .

5. Selecteer  om myocardiale massa-resultaten te genereren.

6. Selecteer  voor alle fasen en alle plakjes.

7. Selecteer  of  of beide.

OPMERKING:  Selecteer voor een optimale RV-segmentatie zowel de epicardiale als de endocardiale sporen.

8. Selecteer  om automatische segmentatie te starten.

OPMERKING:  De knop Start Automatisch Propageren wordt uitgeschakeld als de LV- en RV-selectie beide zijn 
uitgeschakeld.

Controleer juistheid van segmentatie/bewerking

1. Speel de korte-asserie in filmmodus af en controleer de nauwkeurigheid van de contouren.

2. Werk contouren die onnauwkeurig zijn bij.

De fasetoewijzingen voor ED en ES zijn vergrendeld. Om ED of ES opnieuw toe te wijzen, klikt u op de ED- of ES-knop en 
selecteert u het fasenummer direct in de matrix. Vergrendelde fasen worden aangegeven met een lichtere kleur voor de 
driehoek.

3. Controleer de plaatsing van het RV-insertiepunt op elk plakje. Corrigeer het RV-insertiepunt voor de basale plakjes.

4. Bekijk de matrixmodus en bevestig ED- en ES-toewijzingen.

OPMERKING:  Contourbewerking wordt ondersteund voor gladde modus. Voer een contourbewerking uit en selecteer
automatische segmentatie starten.



suiteHEART® Software-gebruiksaanwijzing NS-03-040-0008 Versie�1      58

Voer automatische segmentatie uit voor alle plakjes in één fase

1. Selecteer de korte-asserie en wijzig het venster/niveau.

2. Klik op .

3. Klik op .

4. Selecteer in de segmentatiebalk een gladde  of papillaire modus .

5. Selecteer  om myocardiale massa-resultaten te genereren.

6. Bekijk de korte-asafbeeldingen en selecteer de eind-diastolische fase.

7. Selecteer  of  of beide.

8. Selecteer  voor alle plakjes in één fase.

9. Selecteer  om automatische segmentatie te starten.

10. Bekijk de korte-asafbeeldingen en selecteer de eind-systolische fase.

11. Selecteer  om automatische segmentatie te starten. 

OPMERKING:  De knop Start Automatisch Propageren wordt uitgeschakeld als de LV- en RV-selectie beide zijn 
uitgeschakeld.

Controleer juistheid van segmentatie/bewerking

1. Speel de korte-asserie in filmmodus af en controleer de nauwkeurigheid van de contouren.

2. Werk contouren die onnauwkeurig zijn bij.

3. Bekijk de matrixmodus en bevestig ED- en ES-toewijzingen.

4. Bekijk alle resultaten op de meettabel.
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Procedure voor handmatige LV- en RV-functieanalyse

OPMERKING:  Het wordt aanbevolen om de eind-diastolische en eind-systolische fasen te gebruiken. Het verwerken 
moet in de einddiastolische fase beginnen. De analyse wordt uitgevoerd van de basis tot aan de apex.

1. Selecteer .

2. Selecteer de geschikte korte-asserie uit de beeldweergave.

3. Klik op .

4. Klik op de knop  voor Volumemetingen.

5. Wijs de einddiastolische fase aan.

Het endocard definiëren

1. Selecteer  voor LV of  voor RV. 

2. Breng de endocardiale contour aan.

3. Ga naar het volgende plakje met  of gebruik <- en -> of selecteer de miniatuur.

4. Herhaal stap 2 en 3 tot de hele linker- en/of rechterventrikel is gesegmenteerd.

De Endocardcontourtool blijft geselecteerd om het segmenteren van meerdere plakjes te bespoedigen.

5. Wijs de eindsystolische fase aan.

6. Herhaal stap 2 en 3 aan de eindsystolische fase, tot de hele linker- en/of rechterventrikel is gesegmenteerd.

OPMERKING:  De software bepaalt automatisch de einddiastolische fase als de fase met het grootste volume en de
eindsystolische fase als de fase met het kleinste volume. De einddiastolische en eindsystolische 
fasebepalingen worden tijdens de segmentatie bijgewerkt.

Controleer juistheid van segmentatie/bewerking

1. Speel de korte-asserie in filmmodus af en controleer de nauwkeurigheid van de contouren.

2. Werk contouren die onnauwkeurig zijn bij.

3. Bekijk de matrixmodus en bevestig ED- en ES-toewijzingen.

4. Bekijk alle resultaten op de meettabel.
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Procedure voor handmatige LV- en RV-myocardiale massa

1. Selecteer de relevante hartfase.

2. Selecteer  voor LV-epicard of  voor RV-epicard. 

3. Trek de epicardiale contour na.

4. Ga naar het volgende plakje met  of gebruik <- en -> of selecteer de miniatuur.

5. Herhaal stap 3 en 4 tot het epicard van de hele linker- en/of rechterventrikel is gesegmenteerd.

De massaresultaten worden automatisch bijgewerkt wanneer de epicardiale contouren worden gedefinieerd.

Controleer juistheid van segmentatie/bewerking

1. Speel de korte-asserie in filmmodus af en controleer de nauwkeurigheid van de contouren.

2. Werk contouren die onnauwkeurig zijn bij.

3. Bekijk de matrixmodus en bevestig ED- en ES-toewijzingen.

4. Bekijk alle resultaten op de meettabel.

Basale interpolatie

Om segmentatie-interpolatie voor de basale plakjes uit te voeren, identificeert u de mitralisklep of de annulus van de 
tricuspidalisklep op een lange as-weergave.

OPMERKING:  Automatisch invoegen van de klepring voor de LV en RV kan worden ingesteld in voorkeuren, zie 
Procedure voor het wijzigen van diversenparameters op pagina 33. 

1. Selecteer voor LV-basale interpolatie een 2-kamerweergave in de kruisverwijzingsmodus.

2. Selecteer .

3. Definieer de MV-annulus, zoals weergegeven in Figuur 2. Bekijk de plaatsing van de lijn op de relevante
eindsystolische en einddiastolische fasen met behulp van de cine-knoppen.

OPMERKING:  Multi-vlak basale interpolatie wordt ondersteund. De MV-annulus kan bijvoorbeeld worden 
geïdentificeerd op 2-kamer- en 4 kamer-weergaves; fit wordt uitgevoerd tussen de twee vlakken.
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FIGUUR 2. MV-annulus

4. Controleer de bijgewerkte berekening door de kruisverwijzingsplakjes te beoordelen in relatie tot de lijn.

Zoals weergegeven in Figuur 3, is de geïnterpoleerde volumeberekening gebaseerd op de relatie van het snijpunt tot het 
plakje (roze lijn). Dit volume is nu opgenomen in de volumeresultaten. Het daadwerkelijke te onderzoeken gebied wordt 
niet getoond. Plakjes die zijn geïnterpoleerd, geven het volume aan met het percentage interpolatie in de linkerhoek van 
de afbeelding, zoals weergegeven in Figuur 3.

FIGUUR 3. Volumeberekening

5. Selecteer voor RV-basale interpolatie een 4-kamerweergave in de kruisverwijzingsmodus.

6. Selecteer .

7. Definieer de TV-annulus, zoals weergegeven in Figuur 4. Bekijk de plaatsing van de lijn op de relevante eindsystolische 
en einddiastolische fasen met behulp van de cine-knop.
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FIGUUR 4. TV-annulus

8. Controleer de bijgewerkte berekeningen door de kruisverwijzingsplakjes in relatie tot de lijn te bekijken en bekijk de
ED- en ES-toewijzingen in matrixmodus.

9. Om het resultaat terug te zetten naar de oorspronkelijke waarde, klikt u met de rechtermuisknop en houdt u deze
direct op de regel om verwijderen te selecteren of klikt u met de linkermuisknop op de regel en gebruikt u de delete-
toets op het toetsenbord.

Nauwkeurigheid controleren

1. Speel de lange-asserie in filmmodus en controleer de plaatsing van de lijn.

2. Pas de plaatsing van de lijn naar wens aan.

3. Als automatisch invoegen is uitgevoerd, controleer dan of de juiste serie is geselecteerd en de lijn correct is geplaatst.
Indien niet correct geplaatst, klik met de rechtermuisknop op de lijn en verwijder deze.
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Interpolatiefunctionaliteit 

Bij het uitvoeren van functieanalyses voor de LV of de RV wordt de interpolatiefunctionaliteit uitgeschakeld. 

Interpolatiefunctionaliteit kan worden toegepast voor de volgende omstandigheden:

• Als dezelfde hartfase over plakjes voor zowel eindsystole of eind-diastole wordt getraceerd en een plakje is overgeslagen,
kan de interpolatie worden ingeschakeld door interpolatie „Aan” te selecteren, zoals weergegeven in Figuur 5.

• Als dezelfde hartfase over plakjes wordt getraceerd voor ofwel eind-systole of eind-diastole en/of een plakje is
overgeslagen, kan de basale interpolatie automatisch worden toegepast.

FIGUUR 5. Interpolatie

Beoordeling van eind-diastolische (ED) en eind-systolische (ES) opdrachten

Nadat de segmentatie is voltooid, bekijkt u de matrixmodus en bevestigt u de einddiastolische of eindsystolische 
toewijzingen. 

OPMERKING:  Voor elk ventriculair volume-analysetype verschijnt het volgende bericht, als de einddiastolische (ED) of 
eindsystolische (ES) tracering handmatig op een andere fase wordt uitgevoerd.

Interpolatie UIT Interpolatie AAN
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FIGUUR 6. ROI-indelingsbericht

1. Selecteer de Matrixmodus  knop.

2. Selecteer de plakje-voor-plakje ED-/ES-modus

Het kijkvenster verandert en toont een matrix die alle verkregen plaklocaties en fasen weergeeft. In Figuur 7 zijn alle LV-
eind-diastolische fasen toegewezen zoals aangegeven door de rode driehoeken. De blauwe driehoeken geven de 
toegewezen LV-eindsystolische fasen aan. De rode stippen duiden nog niet toegewezen fasen aan.

3. Om in dit voorbeeld de LV-systolische fasen toe te wijzen, klikt u op de knop  en klikt u op de juiste fase met een
rode stip. Er verschijnt een blauwe driehoek nadat u op het matrixvak hebt geklikt. Zoals getoond in Figuur 8, zijn alle
eind-diastolische en/of eind-systolische toewijzingen nu correct.

4. Herhaal de bovenstaande stappen indien nodig voor de RV. Klik op het tabblad RV voor de RV.

FIGUUR 7. Toewijzing van LV-eind-diastolische fasen FIGUUR 8. Toewijzing van LV-eindsystolische fasen
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Bepaling volumemethode

De volumemethodebepaling voor ED en ES is gebaseerd op de keuze van de schakelknop voor globaal en plakje voor 
plakje.

Tabel 4:  Schakelknop voor volumemethodebepaling

Globale ED/ES Wanneer globaal is geselecteerd, wordt het gecombineerde 
volume gebaseerd op de ED- en ES-toewijzingen op basis van 
dezelfde fase.

Plakje voor 
plakje ED/ES

Wanneer plakje voor plakje wordt geselecteerd, wordt het 
gecombineerde volume gebaseerd op het grootste en kleinste 
volume per fase voor elk plakje. De modus Propageer alle plakjes, 
alle fasen moet worden geselecteerd om dit te activeren.
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Resultaten ventriculaire functieanalyse

Volumecurve

Wanneer autosegmentatie wordt uitgevoerd voor alle fasen en alle plakjes voor LV of RV, wordt een ventriculaire 
volume-tijdcurve gegenereerd, zoals weergegeven in Figuur 9. Deze curve kan in het rapport worden opgenomen. 
Markeringen met schuifjes kunnen worden aangepast.

FIGUUR 9. Resultaten automatische ventriculaire segmentatie

1. Volumetrische resultaten, 2. Volumecurve, 3. Matrixmodus

• De rode cursor markeert het eind-diastolische volume.

• De blauwe cursor markeert het eind-diastolische volume.

• De groene cursor markeert de hoogste uitstootwaarde (HUW) ml/sec. (Interactieve verticale cursor).

• De gele cursor markeert de hoogste vulwaarde (HVW) ml/sec. (Interactieve verticale cursor).

• De overeenkomstige selectie van de beeldfase wordt aangegeven door de witte markering op de volumecurve.

1

2

3
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De volumetrische resultaten worden weergegeven in de metingentabel. 

• Klik met de rechtermuisknop op de omgekeerde gele driehoek voor LV of RV om de ventriculaire massafase-resultaten of
massa-indexfase te bekijken.

• Alleen de uit de tabel geselecteerde fase wordt in het rapport getoond.

FIGUUR 10. Keuzemenu massafase

FIGUUR 11. Tabel kamervolume

Volledige LV en RV volumetrische resultaten worden weergegeven in de Tabel kamervolume. 
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Linker ventriculaire regionale analyse

Met LV-regionale analyse kunnen de resultaten van wandbeweging, wanddikte en wandverdikking worden bekeken.

OPMERKING:  Als de knoppen LV en RV in Functie Korte as beide zijn uitgeschakeld of als de knop voor kamerkeuze in 
Lange as is uitgeschakeld, wordt de knop Start Automatisch Propageren uitgeschakeld. 

1. Voer automatische LV-segmentatie uit voor alle plakjes in alle fasen (zie pagina 57).

2. Bekijk de plaatsing van het RV-insertiepunt op elk plakje en pas het RV-insertiepunt aan voor de basale plakjes.

3. Als u een RV-insertiepunt aan een plaklocatie wilt toevoegen, klikt u op RV-insertiepunt , selecteert u een 
automatisch gesegmenteerde plak en plaatst u het RV-insertiepunt.

4. Bevestig basale, midden en apicale classificatie.

5. Klik op Regionale analyse . Dikte, procentuele verdikking en wandbeweging worden weergegeven in een 
grafiek-, diagram- of tabelindeling.

FIGUUR 12. Regionale analyse
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Dyssynchronie-analyse

Dyssynchronie is een uitbreiding van de resultaten van de regionale analyse waarmee de Temporele Uniformiteit van 
Wanddikte (TUWT) kan worden berekend op basis van informatie over omtrek verkregen uit de regionale analyse. 
Literatuurverwijzing in Tabel 5.

Procedure voor dyssychronie-analyse

1. Automatische procedure LV-segmentatie uitvoeren (Zie “Voer automatische segmentatie uit voor alle plakjes en alle
fasen” op pagina 57.).

2. Selecteer Regionale analyse .

3. Selecteer de dyssychronie-tab.

4. De meettabel toont de resultaten voor elk plakje en het gemiddelde globale resultaat.

5. De globale resultaatberekening is optimaal wanneer alleen LV midden-ventriculaire plakjes daarin worden
opgenomen. Om een resultaat van een plakje uit de globale resultaatberekening te verwijderen, klikt u rechtstreeks
op het vakje met het vinkje in de uiterst rechtse kolom (Figuur 13).

FIGUUR 13. Globale resultatenberekening

Tabel 5:  

Resultaat Referentie

Temporele uniformiteit van 
wanddikte (TUWT)

*Bilchick et al, „Cardiac Magnetic Resonance Assessment of Dyssynchrony and
Myocardial Scar Predicts Function Class Improvement Following Cardiac
Resynchronization Therapy”, JACC, Vol.1:No 5: 2008, p. 561-8
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Procedure voor snelle LV-functieanalyse

1. Selecteer .

2. Selecteer een lange-asserie.

3. Selecteer .

4. Selecteer de  voor propagatie van alle segmenten en alle fasen.

5. Klik op .

OPMERKING:  De knop Start Automatisch Propageren wordt uitgeschakeld als selectie van de lange-asweergave wordt 
uitgeschakeld.

6. Controleer alle traceringen. Zorg ervoor dat de middellijn overeenkomt met de lange as van de linker hartkamer van
basis tot top.

7. Handmatig traceren kan worden uitgevoerd. Klik op  om het endocard van de linker hartkamer te traceren 
voor zowel eind-diastole als eind-systole.

8. Trek voor de berekening van de linker ventriculaire massa het linker ventriculaire epicardium na .

FIGUUR 14. Plaatsing middenlijn

De resultaten worden weergegeven in de Tabel metingen.
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 Atria

Procedure voor handmatige LA-en RA-functieanalyse

1. Selecteer de juiste serie in de beeldweergave.

OPMERKING:  Voor optimale resultaten wordt het aanbevolen om een stapel met 4 kamers te gebruiken voor analyse.
De 4-kamerweergave geeft een betere afbakening van de atriale anatomie.

2. Klik op .

3. Selecteer de -toets

4. Wijs de einddiastolische fase aan.

Het endocard definiëren

1. Selecteer  voor LA-endocard of  voor RA-endocard.

2. Breng de endocardiale contour aan.

3. Ga naar het volgende plakje met  of gebruik <- en -> of klik op de miniatuur.

4. Herhaal stap 2 en 3 tot de hele boezem is gesegmenteerd.

5. Wijs de eindsystolische fase aan.

6. Herhaal stap 2 en 3 aan de eindsystolische fase, tot de hele boezem is gesegmenteerd.

OPMERKING:  De software bepaalt automatisch de einddiastolische fase als de fase met het grootste volume en de
eindsystolische fase als de fase met het kleinste volume. De einddiastolische en eindsystolische 
fasebepalingen worden tijdens de segmentatie bijgewerkt.

7. Als een korte-asweergave is gebruikt, identificeer dan de MV- en/of TV-annulus.
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Procedure voor snelle LA-of RA-functieanalyse

Deze methode wordt uitgevoerd op een lange-asserie. 

1. Klik op .

2. Selecteer een lange-asserie.

3. Selecteer de einddiastolische fase.

4. Selecteer de -toets.

5. Selecteer  voor LA-endocard of  voor RA-endocard.

6. Geef het endocard van de boezem aan. Nu wordt automatisch een centrale rotatielijn aangegeven.

7. Zorg ervoor dat de centrale rotatielijn overeenkomt met de lange as van de boezem.

8. Herhaal de stappen 5-7 voor de eindsystole.

Atriale dimensies en oppervlakte

1. Klik op .

2. Selecteer de relevante serie.

3. Om een atriale dimensiemeting uit te voeren, klikt u rechtstreeks op de tabel in de kolom voor LA of RA en plaatst u
vervolgens twee punten. Zie Figuur 15.

4. Om een atriale oppervlaktemeting uit te voeren, klikt u rechtstreeks op de tabel in de kolom voor LA of RA en tekent
vervolgens een ROI. Zie Figuur 15.

FIGUUR 15. Atriale meting
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Lineaire metingen

Met de applicatie kunnen lineaire metingen worden gerapporteerd. Tooltips zijn beschikbaar door de cursor op de 
meting in de tabel te plaatsen.

FIGUUR 16. Lineaire metingen

1. Afdrukoptie, 2. Tekstinvoerveld voor pericardium, 3. Zelfgedefinieerde meting toevoegen/verwijderen, 4. Wis alle metingen

Instelling Lineaire Metingen

1. Selecteer .

2. Selecteer de serie.

3. Klip op de -knop.

4. Wijs de afbeelding met het te onderzoeken deel aan.

5. Klik op de gewenste meting in de tabel Meting, waardoor de meting groen wordt om aan te geven dat de selectie
actief is.

1

2

3 4
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VOORZICHTIG: Voor goede meetresultaten is het van essentieel belang dat de lijn nauwkeurig wordt geplaatst. 
Uit onnauwkeurige metingen kunnen verkeerde diagnoses volgen. Metingen dienen alleen te 
worden verricht door goed opgeleid en gekwalificeerd personeel.

6. Om te bewerken, klik op annotatie en wanneer de kleur verandert van groen naar paars, is deze actief. Plaats de
cursor boven een van de eindpunten en wijzig die.

Als u de cursor buiten het Image Editor-venster plaatst, wordt de meetafstandwaarde automatisch bijgewerkt in 
de Tabel metingen.

Plaats om de hele meetafstandlijn te verplaatsen de cursor boven de middelste marker.

OPMERKING:  Selecteer om de meting te resetten de meetafstandlijn en open het rechtermuisknopmenu en selecteer 
Verwijderen; of gebruik de Delete-toets op het toetsenbord. 

Metingen wissen

Klik op  om alle metingen te wissen.

Zelfgedefinieerde meting toevoegen

1. Selecteer .

2. Voer een uniek label in in het pop-upvenster Add Custom Measure (Zelfgedefinieerde meting toevoegen).

3. Selecteer bij measurement type (soort meting) Linear (Lineair) of Area (Oppervlakte).

4. Selecteer OK.

Verwijder zelfgedefinieerde meting

1. Selecteer de .

2. Selecteer de uit de lijst te verwijderen zelfgedefinieerde meting(en).

3. Kies Select (Selecteren).

OPMERKING:  Zelfgedefinieerde metingen zijn beschikbaar voor alle toekomstige analyses totdat ze uit de lijst worden
verwijderd.
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Klepvlakanalyse

Met de functie voor klepvlakanalyse kan de pieksnelheid van de klep, de piekdrukgradiënt en de gemiddelde 

drukgradiënt voor de klep worden berekend.1

Met behulp van de resultaten van de LV-autosegmentatie, wordt de drukgradiënt berekend op basis van het 
hartminuutvolume, op basis van de beeld voor beeld veranderingen in het systolische volume van de linker ventrikel.

Procedure voor klepvlakanalyse

1. Voer LV-autosegmentatie uit op alle plakjes in alle fasen (zie pagina 57).

2. Selecteer een serie die de anatomie van de klep toont.

3. Selecteer Klepgebied uit de meettabel (Figuur 17) en voer planimetrie van de klep uit, zoals getoond in Figuur 18.

FIGUUR 17. Klepgebied

4. Na voltooiing van de ROI zal de tabel worden bijgewerkt met de resultaten en een diagram presenteren met de
drukgradiënt in de tijd.

Klik op  om alle metingen te wissen.

1. Wolff, Steven D., MD, Ph.D. Niet-invasieve methoden voor het bepalen van de drukgradiënt over een hartklep zonder snelheidsgegevens 
bij de klepopening te gebruiken. Amerikaans octrooi 9.585.568, 7 maart 2017.
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FIGUUR 18. Klepvlakanalyse

BELANGRIJK: Aanbevolen wordt om de hartanalyse te laten uitvoeren door gekwalificeerd personeel, als de 
analyseresultaten moeten worden gebruikt om een diagnose te stellen.

De applicatie helpt alleen bij de analyse van de afbeeldingen en levert niet automatisch kwantificeerbare 
resultaten op. Het gebruiken en plaatsen van kwantitatieve metingen is aan de gebruiker. Onnauwkeurige 
metingen kunnen leiden tot verkeerde diagnoses. Metingen dienen alleen te worden verricht door goed 
opgeleid en gekwalificeerd personeel.    

OPMERKING:  Pieksnelheid, Piekdrukgradiënt en Gemiddelde Drukgradiënt zijn niet geldig bij patiënten met mitrale 
regurgitatie of een shunt.
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Stroomanalyse
De gebruiker is verantwoordelijk voor de juiste en volledige plaatsing (en correcte toewijzing) van alle interessegebieden (ROI's), 
inclusief de gebieden die zijn gegenereerd of aangepast door de automatische segmentatiealgoritmen. De kwantitatieve waarden 
die door de software worden gegenereerd, zijn afhankelijk van de juiste en volledige plaatsing (en correcte toewijzing) van deze 
interessegebieden.

De functie Voorverwerken van het onderzoek maakt de voorverwerking van stroomanalyse mogelijk. Raadpleeg de 
gebruiksaanwijzing van suiteDXT NS-03-040-0014.

De Stroomanalysetool berekent de stroming en snelheid op diverse punten in de hartcyclus vanuit 2D-
fasecontrastafbeeldingen (FC-afbeeldingen) met vlakstroomcodering.

Er zijn twee methoden voor het genereren van stromingsresultaten: versterkt en conventioneel. Bij versterkte automatische 
segmentatie is niet vereist dat een initiële ROI op het betreffende bloedvat wordt aangegeven, bij conventionele 
automatische segmentatie wel.

OPMERKING:  Bij retrospectieve 2D-fasecontrastseries gemaakt op basis van 4D Flow kan conventionele automatische 
segmentatie vereist zijn.

WAARSCHUWING: De applicatie helpt alleen bij de analyse van de afbeeldingen en levert niet automatisch 
kwantificeerbare resultaten op. Het gebruiken en plaatsen van kwantitatieve metingen is 
aan de gebruiker. Onnauwkeurige metingen kunnen leiden tot verkeerde diagnoses. 
Metingen dienen alleen te worden verricht door goed opgeleid en gekwalificeerd personeel.

WAARSCHUWING: Het gebruik van versterkte automatische segmentatie vereist een zorgvuldige beoordeling 
van alle resultaten. Als de bloedvatidentificatie niet optimaal is, voer dan een conventionele 
automatische segmentatie voor het bloedvat uit.
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Stroomvenstercomponenten

FIGUUR 1. Stroomvenster 

1. ROI's voor stroomanalyse, 2. Stroomtabbladen, 3. Actieve ROI/versterkte automatische selectie, 4. Propagerentoetsen, 5. ROI-verwijderknop,
6. Vervolgkeuzemenu uitgangswaardecorrectie, 7. Ruispixels uitsluiten, 8. Stroomverschuiving, 9. Expansiefactor, 10. Venc-schuifbalk,
11. Stroomresultatencurve,12. Weergavemodus, 13. Faseverschuiving, 14. Schakel naar grafiekweergave, 15. Schakel naar overzichtstabel

OPMERKING:  Stroomanalyse geeft de grootte- en fasebeelden weer in een beeldweergave naast elkaar. Andere
soorten afbeeldingen die op dezelfde locatie zijn verkregen, worden niet weergegeven en moeten in 
een afzonderlijke DICOM-viewer worden bekeken.

OPMERKING:  Bij het bekijken van eerdere onderzoeken met stroomanalyse zal er een kleurafwijking zijn tussen 
grafiek en nummer 2 (blauw) stroompictogram ROI.

1

2
3

4

5
6

7

8 9

10

11

12 13

14 15
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Stroomanalyse

Genereer stroomresultaten

Versterkte automatische segmentatie gebruiken

Bij versterkte automatische segmentatie is niet vereist dat een initiële ROI op het bloedvat wordt aangegeven. Het is 
belangrijk om het juiste stroomtabblad te selecteren dat overeenkomt met de verkregen anatomie van het bloedvat. 
Alleen aorta- en longanatomie wordt ondersteund. 

OPMERKING:  Als er meer dan zes bloedvaten worden verkregen voor fasecontrast per tabblad, behoudt de functie 
Voorbewerking alleen de zes meest recente resultaten.

Genereer een aortastroomcurve

1. Selecteer de juiste serie die het aortavat demonstreert, zoals getoond in Figuur 2.

FIGUUR 2. Aortavat

2. Selecteer het tabblad Aorta en selecteer de actieve ROI-kleur, zoals weergegeven in Figuur 3.

FIGUUR 3. Tabblad Aorta
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3. Selecteer  om een stroomcurve te genereren.

4. Bekijk de segmentatie op het bloedvat. Als het verkeerde bloedvat gesegmenteerd is, voer dan een conventionele
automatische segmentatie uit. Zie Conventionele automatische segmentatie gebruiken op pagina 81.

5. Klik op een contour, om te bewerken, voer de bewerking uit en klik op .

Genereer een longstroomcurve

1. Selecteer de juiste serie die het longvat demonstreert, zoals getoond in Figuur 4.

FIGUUR 4. Longvat

2. Selecteer het tabblad PA en selecteer de actieve ROI-kleur, zoals weergegeven in Figuur 5.

FIGUUR 5. Tabblad PA

3. Selecteer  om een stroomcurve te genereren.

4. Bekijk de segmentatie op het bloedvat. Als het verkeerde bloedvat gesegmenteerd is, voer dan een conventionele
automatische segmentatie uit. Zie Conventionele automatische segmentatie gebruiken op pagina 81.
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5. Klik op een contour, om te bewerken, voer de bewerking uit en klik op .

WAARSCHUWING: Het gebruik van versterkte automatische segmentatie vereist een zorgvuldige beoordeling 
van alle resultaten. Als de bloedvatidentificatie niet optimaal is, voer dan een conventionele 
automatische segmentatie voor het bloedvat uit.

Conventionele automatische segmentatie gebruiken

1. Selecteer de stroomanalysemodus . 

2. Selecteer een fasecontrastserie.

Het magnitudebeeld wordt links weergegeven, het fasebeeld rechts.

FIGUUR 6. Magnitude- en fasebeelden

3. Selecteer een stroomtab.

Er zijn vijf tabbladen beschikbaar; één gelabeld aorta, één longslagader (PA) en twee door de gebruiker gedefinieerde 
tabbladen met standaardlabels van Stroom 3 en Stroom 4. Op het tabblad Qp/Qs kunt u de Qp/Qs-ratio rapporteren.

4. Selecteer  curve 1. 

Er zijn zes ROI's beschikbaar, genummerd 1 - 6. De kleurcode is hetzelfde in de analyseweergave, 
afbeeldingkijkvensters en diagrammen.

5. Creëer een contour rond een bloedvat door 4 punten rond het betreffende vat te plaatsen en op het laatste punt te
dubbelklikken om de ROI af te bakenen. U kunt ook de cursor uit het editorvenster verplaatsen om de ROI af te bakenen.

Er kan ook handmatig een spoor van het vat worden getrokken.

De contour wordt gemaakt op zowel de magnitude- als de faseafbeeldingen, zoals weergegeven in Figuur 7.
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FIGUUR 7. Stroom-ROI's

6. Selecteer een van de propagatiemethoden om binnen de plak automatische segmentatie voor alle fasen uit te voeren:

• Kies  voor automatische segmentatie voor alle fasen in de plak.

Of

• Kies  ervoor om dezelfde contour over alle fasen in de plak over te dragen. Dit is vooral handig voor het analyseren 
van kleine, stationaire bloedvaten.

7. Stroomresultaten worden getoond in het diagram en de overzichtstabellen.

• Klik het vinkje aan in het hokje naast de verhouding ml/hartslag om de bijbehorende curve uit het diagram te verwijderen.
Dit heeft geen effect op de berekeningen. De curve wordt alleen niet meer getoond in het diagram.

8. Selecteer een optie voor Uitgangswaardecorrectie in de keuzebestanden.

• Curven met een toegepaste Uitgangswaardecorrectie hebben gegevenspunten in de vaste fase, zoals weergegeven in

Figuur 8. Zie Opties voor Basislijncorrectie op pagina 84.

FIGUUR 8. Stroomdiagram - Geen correctie (linker diagram); Correctie toegepast (rechter diagram) 
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9. Selecteer  om de curve om te keren.

OPMERKING:  Alle gegenereerde stroomcurven worden in een positieve richting weergegeven. Omgekeerde curven 
worden aangegeven door de actieve omkeerknop.

10. Selecteer een faseverschuiving om de ordinaat van de stroomcurve te veranderen.

11. Selecteer een punt in het diagram om de bijbehorende faseafbeelding te vinden.

12. Pas indien nodig de verticale cursor aan voor het begin- en eindpunt.

13. Controleer de juistheid van de contouren.

Contouren wijzigen

Contouren kunnen worden gewijzigd per fase of per meerdere fasen.

Het wijzigen van een enkele fase

1. Selecteer de gewenste fase om te wijzigen.

2. Klik op de contour, zodat hij wordt geactiveerd en kan worden gewijzigd.

De contour wordt paars, wat betekent dat hij kan worden gewijzigd.

3. Wijzig de contour door punt voor punt de splinecontouren te verplaatsen of door met de linkermuistoets ingedrukt
uit de vrije hand of met de computer in de afbeelding te tekenen.

4. Klik met de linkermuisknop op de contour om de nudge-functie te activeren. Klik vervolgens met de rechtermuisknop
en selecteer de nudge-functie in het pop-upmenu, zoals weergegeven Figuur 9. Raadpleeg Contouren wijzigen op
pagina 51 voor meer informatie

FIGUUR 9. Nudge-functie
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Het wijzigen van meerdere fasen

1. Selecteer de gewenste plak.

2. Selecteer  om de thumbnails te tonen van alle fasen van een bepaalde plak.

3. Selecteer de eerste fase van de te wijzigen reeks fasen.

4. Houd de shift-toets ingedrukt en selecteer de laatste fase van de te wijzigen reeks.

5. Wijzig de contour in het Image Editor-venster.

6. Deselecteer de contour door buiten de geselecteerde contour op de afbeelding te klikken of door de cursor buiten
het bewerkingsvenster te verplaatsen.

Opties voor Basislijncorrectie

Er zijn drie correctiemethoden voor de stroombasislijn voor 2D-fasecontrast. Stroomcurven waarop een 
correctiemethode is toegepast, hebben gegevenspunten in de vaste fase.

OPMERKING:  Fasecontrastafbeeldingen die worden gebruikt voor analyse mogen geen faseomloop in de afbeelding 
hebben. Faseomloop in de afbeelding zal onjuiste stroomresultaten tot gevolg hebben.

Automatische Basislijncorrectie

De Automatische basislijncorrectie corrigeert fasefouten die optreden tijdens beeldverwerving door de fasefout in verre 
stationaire organen (bijvoorbeeld borstwand, lever, enz.) te onderzoeken en de gegevens ruimtelijk in te passen met behulp 
van lineaire of hogere orde interpolatie.

OPMERKING:  Als een 2D-magnitude- en faseserie wordt gemaakt met behulp van de 3D/4D-viewer, maakt de 
applicatie een niet-gecorrigeerde serie en een tweede serie waarop fasefoutcorrectie is toegepast.  
Pas Automatisch uit het keuzemenu basislijncorrectie niet toe op de serie met het label „Gecorrigeerd”.

1. Genereer een stroomcurve met de juiste fasecontrastseries.

2. Selecteer Automatisch in het keuzemenu Basislijncorrectie.

OPMERKING:  Automatische basislijncorrectie wordt automatisch toegepast als Automatische basislijncorrectie inschakelen 
is aangevinkt in Voorkeuren.

3. De correctie wordt toegepast met de bijgewerkte resultaten direct in het stroomdiagram weergegeven.

4. Series die niet passen bij de aanpassingsanalyse, worden aangegeven met een waarschuwingssymbool, zoals
weergegeven in Figuur 10.
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FIGUUR 10. Basislijncorrectiefout 

OPMERKING:  Faseomloop in de afbeelding zal onjuiste stroomresultaten tot gevolg hebben, zoals weergegeven in 
Figuur 11. 2D-Cine Fasecontrastafbeeldingen die worden gebruikt voor stroomanalyse mogen geen 
faseomloop in de afbeelding hebben, zoals weergegeven in Figuur 12.

FIGUUR 11. Voorbeeldafbeeldingen met faseomloop (witte pijlen)

FIGUUR 12. Voorbeeldafbeeldingen zonder faseomloop

Typen fouten:
1 - Te veel ruis op de afbeelding.
2 - Aanpassingsfout is te groot.
3 - Invoergegevens zijn ongeldig.
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FANTOOMCORRECTIE

Om de nauwkeurigheid van de resultaten van het fasecontrast te verbeteren en om te corrigeren voor fouten in de 
basislijnfaseverschuiving, kan een fantoomverwerving worden gebruikt om deze fout te berekenen.

OPMERKING:  De fantoomcorrectieserie moet zijn verkregen met dezelfde scanbepaling en parameters als de originele 
fasecontrastserie. Er moet een signaal komen van een stationair voorwerp dat de contour op de 
fantoomserie helemaal opvult.

1. Genereer een stroomcurve met de juiste fasecontrastseries.

2. Selecteer de bijbehorende fantoomserie in het keuzemenu Basislijncorrectie.

3. De correctie wordt toegepast met de bijgewerkte resultaten direct in het stroomdiagram weergegeven.

Correctie van achtergrondcontouren 

Deze correctiemethode kan worden overwogen voor vaten die zijn omgeven door vast weefsel.

OPMERKING:  Voor een optimale correctie moet de achtergrondcontour worden geplaatst in vast weefsel vlak naast 
en om het stroomgebied.

1. Genereer een stroomcurve met de juiste fasecontrastseries.

2. Selecteer de Achtergrond-ROI in het keuzemenu Basislijncorrectie.

3. Klik op  om een contour te tekenen.

4. De correctie wordt toegepast met de bijgewerkte resultaten direct in het stroomdiagram weergegeven.
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Stroomcurveopties

Ruispixels uitsluiten

Deze optie herkent pixels met lage intensiteit (hoge schommeling van snelheden) indien aanwezig binnen de ROI, 
aangegeven met de roze overlay zoals getoond in Figuur 14 en sluit ze uit van de stroomberekening. Klik op het 
selectievakje om deze optie toe te passen. Het percentage ruispixels kan worden aangepast met de schuifbalk.

FIGUUR 13. Ruispixels

FIGUUR 14. Ruispixels aangegeven door middel van roze overlay

Stroomverschuiving

Stroomverschuiving verandert de absciswaarde van de stroomcurve, waardoor de basislijnwaarden van het 
stroomresultaat veranderen.
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Expansiefactor

De expansiefactor verandert gelijkmatig de radius van het gesegmenteerde bloedvat met een gespecificeerde 
pixelhoeveelheid om geldige stroompixels op te nemen.

Correctie van snelheidsaliasing

Versleep de schuifregelknop om phase unwrapping uit te voeren om te corrigeren voor snelheidsaliasing. Het effect van 
de wijziging wordt direct op het fasebeeld bijgewerkt en de resultaten worden direct in de stroomdiagram weergegeven.

Door de gebruiker gedefinieerde pieksnelheid

1. Selecteer de juiste fase in de hartcyclus.

2. Plaats met  de cursor boven het fasebeeld.

De cursor wordt gesynchroniseerd met zowel de magnitude- als de fasebeelden. Het snelheidsresultaat verschijnt 
in mm/s op het fasebeeld naast de cursor.

FIGUUR 15. Pixelstroomsnelheid
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Weergavemodi

Selecteer de gewenste Display Mode (Weergavemodus) in het keuzemenu (Figuur 16).

FIGUUR 16. Menu weergavemodi

Definities van stroomweergavemodi:

Stroom: Deze figuur toont een grafiek weer die het stroomvolume van elke fase in de gehele hartcyclus voorstelt 
(standaard). Elk punt op de curve vertegenwoordigt de stroom voor die fase.

Positief: Deze diagram toont de som van het positieve stroomgebied gedurende de hartcyclus.

Negatief: Deze diagram toont de som van het negatieve stroomgebied gedurende de hartcyclus.

Piek totaal: Deze figuur toont een grafiek van piekpositieve en -negatieve snelheden voor elke fase van de hartcyclus.

Piek absoluut: Deze figuur toont een grafiek van absolute pieksnelheid voor elke fase.

Histogram: Deze diagram toont een grafiek van de snelheid van elke pixel binnen elk interessegebied voor elke fase van de 
hartcyclus.

Regurgitatie: De regurgitantfractie (%) is het quotiënt van de negatieve stroom gedeeld door de totale positieve stroom.

Drukhalfwaardetijd (PHT): De tijd die nodig is om de piek transmitrale drukgradiënt met de helft te verminderen. 

Histogrammodus

Selecteer de histogrammodus om een grafiek van snelheden per pixel en de berekening van de piek- en gemiddelde 
drukgradiënt weer te geven.

1. Genereer een stroomcurve met de juiste fasecontrastseries.

2. Selecteer Histogram uit het keuzemenu Weergavemodus.

3. Klik direct op de diagram om een dradenkruiscursor op het fasebeeld te activeren, die de bijbehorende locatie van
die pixel aangeeft.

4. Gebruik de dubbele pijlknoppen onderaan de diagram om de hoogste of laagste snelheidswaarde te vinden, (Figuur 17.)

5. Gebruik de enkele pijlknoppen om stap voor stap door de snelheidswaarden te gaan, zoals weergegeven in Figuur 17.

OPMERKING:  De serielokalisatiefunctie wordt uitgeschakeld in de histogrammodus wanneer u rechtstreeks op de
stroomcurve klikt. Schakel naar de stroommodus om de lokalisatiefunctionaliteit in te schakelen.

OPMERKING:  Om ervoor te zorgen dat de bijbehorende magnitude- en faseafbeeldingen worden weergegeven, moet u 
met één stroomcurve tegelijk werken en de andere histogramcurven in de grafiekweergave deselecteren.

OPMERKING:  Onderzoeken die zijn geanalyseerd met behulp van de histogrammodus met een eerdere versie van 
suiteHEART® Software moeten opnieuw geanalyseerd worden. 
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FIGUUR 17. Histogrammodus

Regurgitatiemodus

Selecteer de Regurgitatiemodus om de negatieve stroom en regurgitantfractie te berekenen.

1. Genereer een stroomcurve met de juiste fasecontrastseries.

2. Selecteer Regurgitatie uit het keuzemenu Weergavemodus.

3. Controleer de plaatsing van de zwarte verticale cursors. De cursors moeten aan het begin en einde van de retrograde
stroom worden geplaatst, zoals getoond in Figuur 18.

De resultaten staan in de rechterbovenhoek van het stroomdiagram en in de overzichtstabel. 

FIGUUR 18. Regurgitatieresultaten
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Drukhalfwaardetijd

De drukhalfwaardetijd (PHT) kan worden verkregen door het meten van de deceleratietijd van de E-golf op 
fasecontrastbeelden die zijn verkregen van de mitralisklep. Met deze modus kan de helling van de grafiek worden bepaald 
om het PHT- en mitralisklepoppervlak (MVA) te berekenen.

1. Genereer een stroomcurve met de juiste fasecontrastseries van de mitralisklep.

2. Gebruik voor de ROI-propagatie de optie copy paste.

3. Selecteer Drukhalfwaardetijd uit het keuzemenu Weergavemodus.

4. Klik direct op de grafiek om de hoogste snelheid van het deceleratiegedeelte van de curve aan te geven.

5. Klik op een eindpunt om de helling van de curve te berekenen zoals weergegeven in Figuur 19.

6. Om de berekening opnieuw in te stellen, plaatst u de cursor op een eindpunt, klikt u met de rechtermuisknop en
selecteert u de prullenbak.

FIGUUR 19. Drukhalfwaardetijdresultaten

OPMERKING:  Resultaten van het Mitralisklepgebied (MVA), Drukhalfwaardetijdresultaten (PHT) zijn niet geldig bij 
patiënten met aorta-insufficiëntie, cardiale shunt of verminderde ventriculaire compliantie.

OPMERKING:  De serielokalisatiefunctie wordt uitgeschakeld in de PHT-modus wanneer u rechtstreeks op de 
stroomcurve klikt. Schakel naar de stroommodus om de lokalisatiefunctionaliteit in te schakelen.

Referentie:

http://www.csecho.ca/mdmath/?tag=mvapht
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Stroomresultaten controleren

FIGUUR 20. Stroomresultaten

1. Keuzemenu ROI, 2. Stroomresultaten, 3. Grafiekpictogram, 4. Stroomresultaten/Stroomtabelpictogram.

1. Selecteer All ROIs (Alle ROI's) in het keuzemenu om de resultaten van alle curven te controleren.

2. Selecteer  om de stroomresultaten of stroomtabel te bekijken. 

3. Klik op het selectievakje om het resultaat in het rapport op te nemen of eruit te laten.

4. Selecteer  om te schakelen tussen de stroomresultaten en de stroomtabel.

5. Selecteer  om de stroomcurves te bekijken.

1

2

43
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Tabblad Qp/Qs 

Het Qp/Qs-rapportvenster heeft een andere lay-out dan die van de bloedvatstroomtabs.

FIGUUR 21. Qp/Qs-rapportagevenster

1. Aortacurve, 2. Longslagadercurve, 3. Qp/Qs-meting, 4. Stroomcurven

1

2

3

4
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Qp/Qs berekenen

OPMERKING:  Stroomcurven moeten worden aangemaakt in de juiste serie voor de aorta en longslagader voorafgaand 
aan de Qp/Qs-berekeningen.

1. Selecteer ten minste één aortacurve.

2. Selecteer ten minste één longslagadercurve.

De Qp/Qs-berekeningen worden automatisch uitgevoerd, als de contouren van de aorta en de longslagader 
worden geselecteerd. Het selecteren van contouren heeft invloed op de berekeningen. Alle stroomcurven 
worden in de diagram getoond. Curven kunnen op elk gewenst moment worden ge(de)selecteerd.

Het deselecteren van een curve in de diagram heeft geen invloed op de berekeningen.

Het systeem zal een gemiddelde van de waarden nemen als meer dan een aorta of longslagader wordt 
geselecteerd.

3. Selecteer, indien gewenst, Qp/Qs verwijderen om de diagram en alle berekeningen op deze tab te resetten.
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Wijzig tablabels

FIGUUR 22. Stroomanalysetabs 

Wijzig tablabels:

1. Klik met de rechtermuisknop op het tabblad (Figuur 22).

2. Voer de nieuwe labelnaam in (Figuur 23).

FIGUUR 23. Pop-upvenster voor het wijzigen van een tablabel

OPMERKING:  Als u de labels van het stroomtabblad wijzigt, wordt de labeltitel alleen voor het rapport gewijzigd.

Wijzig de labels van de stroomcurvelegenda’s

1. Klik met de rechtermuisknop op Curve 1 onderaan de stroomdiagram (Figuur 24).

FIGUUR 24. Stroomlegenda’s

2. Voer de nieuwe labelnaam in.

FIGUUR 25. Wijzig het venster voor de labels van de stroomcurvelegenda’s

OPMERKING:  De nieuwe stroomcurvelegenda’s worden opgeslagen met de huidige sjabloon.
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Myocardevaluatie 
De gebruiker is verantwoordelijk voor de juiste en volledige plaatsing van alle interessegebieden (ROI's), inclusief de gebieden die 
zijn gegenereerd of aangepast door de automatische segmentatiealgoritmen. De kwantitatieve waarden die door de software 
worden gegenereerd, zijn afhankelijk van de juiste en volledige plaatsing van deze interessegebieden en toegepaste 
drempelvoering.

De functie Voorverwerken van het onderzoek maakt de voorverwerking van late aankleuring mogelijk. Raadpleeg de 
gebruiksaanwijzing van suiteDXT NS-03-040-0014.

De analysetool Myocardevaluatie (ME) helpt bij het kwantitatief bepalen van gebieden met verschillende signaalsterktes 
binnen het myocard. 

Er zijn drie analyse-tabbladen beschikbaar:

• Late aankleuring - bepaalt myocardiale segmenten met verhoogde en lage signaalintensiteit.
• T2 - bepaalt myocardiale segmenten met verhoogde signaalintensiteit met behulp van beeldvormingstechnieken met

zwart bloed.
• Signaaldifferentie - Geeft de Salvage Mass-resultaten weer met behulp van zowel late aankleuring en T2-analyse als de T2-

signaalintensiteitsverhouding (SI).

FIGUUR 1. Analyse-tabs

WAARSCHUWING: De applicatie helpt alleen bij de analyse van de afbeeldingen en levert niet automatisch 
kwantificeerbare resultaten op. Het gebruiken en plaatsen van kwantitatieve metingen is 
aan de gebruiker. Onnauwkeurige metingen kunnen leiden tot verkeerde diagnoses. 
Metingen dienen alleen te worden verricht door goed opgeleid en gekwalificeerd personeel.



suiteHEART® Software-gebruiksaanwijzing NS-03-040-0008 Versie�1      97

Procedure voor kwantitatieve analyse van ME 

Late aankleuring 

1. Selecteer .

2. Selecteer het tabblad Late aankleuring.

3. Selecteer de relevante korte-asserie.

4. Selecteer  om automatische segmentatie uit te voeren.

5. Bekijk alle endocardiale en epicardiale sporen, RV-insteekpunt en de drempelvoering op elke slice. Bewerk
drempelvoering indien nodig.

FIGUUR 2. Rapportvenster voor kwantitatieve analyse van ME

1. Resultatentabel, 2. Type poolcoördinatendiagram, 3. Onderdeel poolcoördinatendiagram, 4. Tabelonderdeel, 5. Verwijderen,
6. Kwantitatief poolcoördinatendiagram

1

2 

3

5 

6

4
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6. Om handmatige segmentatie uit te voeren, traceert u het LV-endocard op het meest basale segment door

 te selecteren.

7. Geef het LV-epicard aan door  te selecteren.

8. Plaats het onderste RV-insteekpunt door  te selecteren. 

9. Plaats de cursor buiten het editorvenster om de ROI te voltooien.

10. Herhaal stap 6 - 9 tot de hele ventrikel is gesegmenteerd.

11. Bevestig de basale, midden en apicale classificatie.

Selectie drempelvoering

1. Selecteer het juiste drempelvoeringalgoritme in het vervolgkeuzemenu voor bestanden (Figuur 3).

FIGUUR 3. Menu drempelvoeringalgoritme

2. Klik indien nodig op  om de drempelvoeringwaarde voor die slice te maximaliseren. Klik op  om 
die waarde op alle plakken toe te passen. Gebruik de schuifbalk om het drempelvoeringsalgoritme voor elk slice aan
te passen, indien nodig.

3. Voor gemiddelde +2 tot +7 SD-resultaten plaatst u een normale ROI  in een normale myocardium-slice. Deze 
ROI wordt naar alle segmenten gekopieerd als de Propageren Normaal ROI is aangevinkt.

Bewerking drempelvoering

1. Selecteer  om gebieden met een hoge signaalintensiteit toe te voegen. 

2. Selecteer  om gebieden met een lage signaalintensiteit toe te voegen.

3. Selecteer  klein gumgereedschap of  groot gumgereedschap om beide signaalintensiteitsgebieden te 
verwijderen.
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Polaire Plot weergaveformaten

De ME-analysetool heeft 2 polaire plotformaten: Een 16-segmentenformaat en een concentrisch formaat

Optie 1: De 16-segmentenprocedure

1. Selecteer de tab 16-segmenten .

2. Selecteer 2 Gekleurd, 4 Gekleurd of Continu.

Kleurtoewijzingen kunnen worden gedefinieerd door op de kleurenschaalbalk te klikken.

Klik en sleep rechtstreeks naar de kleurverdeler om de percentagewaarden te wijzigen.

FIGUUR 4. Poolcoördinaten

3.  Selecteer  om de Overzichtstabel poolcoördinaten weer te geven.

Optie 2: Het schijf-voor-schijfformaat

1. Selecteer de Concentric (Concentrische)-tab.

FIGUUR 5. Concentrische tab

2 Gekleurde poolcoördinatendiagram 4 Gekleurde poolcoördinatendiagram Doorlopende gekleurde poolcoördinatendiagram
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De concentrische tab biedt de voorkeuren die het formaat van de poolcoördinatendiagram veranderen in een schijf-voor-
schijfformaat, waarin elke ring een schijf vertegenwoordigt. Het aantal ringen wordt bepaald door het aantal 
geanalyseerde schijven.

2. Selecteer het aantal sectoren.

3. Controleer de subsectoren om de percentuele veranderingen van de ROI-massa binnen de sector te tonen.

Als de subsector wordt geselecteerd, wordt een effeningfunctie toegepast.

4. Vink het vakje naast Continuous (Continu) aan om de poolcoördinatendiagram te veranderen in procenten
signaalsterkte en de waarden te kleuren in een continu spectrum van 0-100%.

Klik op  om contouren te wissen.

OPMERKING:  De semiautomatische drempelvoering voor analyse van late verbeteringen werkt optimaal op myocardiale 
evaluatiebeelden van hoge kwaliteit, zoals hieronder weergegeven (afbeelding A). In afbeeldingen die zijn 
verkregen zonder signaal van de bloedpool (afbeelding B) of onjuiste inversietijd, moet de drempelvoering 
subjectief worden ingesteld door de gebruiker. 

FIGUUR 6. Myocardiale evaluatiebeelden

T2-analyse

1. Selecteer de T2-tab.

2. Als de late uitbreidingsreeks eerder is geanalyseerd, kunnen de ROI's worden gekopieerd naar de T2-serie door op de
knop Kopiëren te klikken (zie Figuur 7).

OPMERKING:  Om ROI's te kopiëren, is het vereist dat het aantal slices overeenkomt voor elke serie om nauwkeurige 
resultaten te krijgen; als het aantal slices niet overeenkomt, is de knop Kopiëren niet beschikbaar. Het 
DICOM-importproces kan worden gebruikt om de juiste serie te maken die hetzelfde aantal slices bevat. 
Acquisitieparameters, zoals matrix en FOV, moeten voor elke serie hetzelfde zijn voor de beste 
resultaten. Bekijk na het uitvoeren van een kopie de ROI's zorgvuldig op alle plaklocaties en breng de 
juiste bewerkingen aan. 



suiteHEART® Software-gebruiksaanwijzing NS-03-040-0008 Versie�1    101

FIGUUR 7. Locatie van knop Kopiëren

3. Als er geen eerdere late verbeteringsanalyse is, kunnen de ROI's handmatig worden gemaakt.

4. Geef het LV-endocard op de meest basale schijf aan door  te selecteren.

5. Geef het LV-epicard aan door  te selecteren.

6. Markeer het onderste RV-insteekpunt door  te selecteren.

7. Plaats de cursor buiten het editorvenster om de ROI te voltooien.

8. Herhaal stap 4-7 tot de hele ventrikel is gesegmenteerd.

9. Om een 2 standaardafwijking drempelvoering uit te voeren, selecteert u Normale ROI toevoegen  en plaatst u 
een ROI in een normaal myocardiumsegment. Deze ROI wordt naar alle segmenten gekopieerd als de Propageren 
Normaal ROI is aangevinkt. Controleer elke slicelocatie en pas indien nodig de ROI aan.

OPMERKING:  Wanneer de skeletspier ROI en Normale ROI worden verstrekt, voert de software de volgende 
berekening uit:

Genormaliseerde myocardiale T2 SI = SI myocardium / SI skeletspier; 

Drempelvoeringberekening: Drempelvoering = 2 * STD NORMAAL + AVG NORMAAL

10. Bevestig de basale, midden en apicale classificaties. Gebruik de schuifbalk om het drempelvoeringsalgoritme voor elk
plakje aan te passen, indien nodig.

11. Om T2 Signaalintensiteitsanalyses uit te voeren, selecteert u de Toevoegen Skeletspierweefsel ROI  en plaatst 
u een ROI in de skeletspieren. Deze ROI wordt naar alle afbeeldingen gekopieerd. Controleer elke slicelocatie en pas
indien nodig de ROI aan.

OPMERKING:  Zwartbloedbeelden kunnen onvoldoende stroomonderdrukking hebben, wat kan leiden tot een 
onnauwkeurige signaalintensiteitsanalyse en drempelvoering.
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Bewerken

Selecteer om gebieden met een hoge T2-signaalintensiteit toe te voegen.

Als u gebieden met een hoge T2-signaalintensiteit wilt verwijderen, selecteert u  klein gumgereedschap of 

 groot gumgereedschap.

Klik op  om contouren te wissen.
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Gecombineerde analyse

Late aankleuring en T2

De gecombineerde-analysemodus maakt analyse naast elkaar mogelijk met bewerkingstools voor late aankleuring en T2 
(oedeem) afbeeldingen.

OPMERKING:  Om de gecombineerde-analysemodus in te schakelen, moet de analyse van een late aankleuringsserie 
met korte assen eerst worden voltooid met behulp van het tabblad Late aankleuring. T2 (oedeem) 
afbeeldingen moeten aanwezig zijn in hetzelfde onderzoek. 

1. Selecteer .

2. Selecteer een geschikt onderzoek met zowel late aankleurings- als T2 (oedeem) afbeeldingen. Voltooi de
analyseprocedure voor late aankleuring.

OPMERKING:  Controleer de drempel voor elk segment van de korte as op het tabblad Late Aankleuring voordat u de 
gecombineerde analysemodus selecteert. 

3. Selecteer het tabblad T2 en voltooi de analyseprocedure voor de T2-serie.
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4. Selecteer  om de gecombineerde analyse te starten, zoals weergegeven inFiguur 8.

FIGUUR 8. Gecombineerde analysemodus

5. Na selectie verschijnen de eerder geanalyseerde late aankleuringsseries in het modusweergavevenster. Dit venster
wordt vervolgens een editorvenster voor de late aankleuringsafbeeldingen.

6. Gebruik voor het bewerken van de late aankleuringsafbeeldingen de bewerkingstools onder het kijkvenster zoals
weergegeven in Figuur 9.

OPMERKING:  Bevestig alle bijwerkingen van de resultaten rechtstreeks op het tabblad Late aankleuring.

OPMERKING:  Als de LV-endocard of LV epicard ROI's zijn verwijderd, gaat u terug naar het tabblad Late aankleuring 
om ze te reconstrueren.

T2 (oedeem) Late
aankleuring
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FIGUUR 9. Bewerkingstools voor late aankleuring

7. Gebruik voor het bewerken van de T2-serie (oedeem) aan de linkerkant de bewerkingstools boven het beeldvenster,
zoals weergegeven in Figuur 10.

FIGUUR 10. T2 (oedeem) analysetools
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8. Gebruik de min- en plus-knoppen om naar een ander segmentniveau te navigeren voor de late aankleuringsseries, zoals
weergegeven in Figuur 11.

• Locatie-informatie van slices bevindt zich in de rechterbenedenhoek van elke viewport.

OPMERKING:  De slicelocatie die wordt weergegeven voor de late aankleuring wordt bepaald door de slicelocatie in 
het T2 (Oedeem) bewerkingsvenster. Gebruik de min/plus-knoppen om deze selectie te overschrijven. 

FIGUUR 11. Slicenavigatie regelt late verbetering 

9. Gebruik de min- en plustoetsen onder het T2-bewerkingsvenster (oedeem) om naar een ander sliceniveau te
navigeren voor zowel de late verbetering als de T2-reeks (Oedeem), zoals weergegeven in Figuur 12.

OPMERKING:  In de gecombineerde analysemodus zijn de plus- en minknoppen op de linkernavigatie links voor beide viewports.

FIGUUR 12. Gecombineerde slicenavigatiebesturing

Slicelocatie Slicelocatie
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Verschillende signaalresultaten

Selecteer het tabblad Signaalverschil

OPMERKING:  Late verbetering en T2-analyse moeten worden voltooid om de Salvage Mass Results te verkrijgen. 
De T2-analyse moet worden voltooid met de plaatsing van de ROI van de skeletspier voor T2 
Signaalintensiteit (SI) -analyse.

OPMERKING:  Als het T2-resultaat (Oedeem) minder is dan het resultaat van de late verbetering (Infarct + MVO), 
zal het Salvage Mass-resultaat blanco zijn.

FIGUUR 13. Tabblad Verschillende signalen
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T1-mappinganalyse
Deze functie maakt de signaalkwantificering van de longitudinale spinrooster-relaxatietijd (T1) mogelijk. De applicatie 
ondersteunt T1-analyse voor zowel originele (niet-aangekleurde) afbeeldingen als afbeeldingen na aankleuring en de 
berekening van de extracellulaire volumefractie (ECV).

Vereiste afbeeldingen: Herstelafbeeldingen voor inversie of verzadiging met verschillende inversietijden (TI). Series 
waarop beweging gecorrigeerd is worden aanbevolen voor analyse. Representatieve plaklocaties voor de 
linkerventrikelbasis, midden en apex worden aanbevolen.

WAARSCHUWING: De applicatie helpt alleen bij de analyse van de afbeeldingen en levert niet automatisch 
kwantificeerbare resultaten op. Het gebruiken en plaatsen van kwantitatieve metingen is 
aan de gebruiker. Onnauwkeurige metingen kunnen leiden tot verkeerde diagnoses. 
Metingen dienen alleen te worden verricht door goed opgeleid en gekwalificeerd personeel.

Start T1-mappinganalyse

1. Selecteer .

2. Selecteer de relevante T1-mappingserie.

3. Selecteer het relevante tabblad: Basis, Midden of Apex.

4. Selecteer de juiste korte as-plak uit de serielijst of het miniaturenpaneel.

5. Selecteer MOLLI voor de analyse van afbeeldingen voor inversieherstel of verzadigingsherstel.

FIGUUR 1. T1-mappinganalyse
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Oorspronkelijke T1-analyseprocedure

1. Om regionale T1-analyse uit te voeren, selecteert u de Native Local ROI-tool  en maakt u een interessegebied 
in het myocard.

2. Het originele lokale T1-resultaat voor het gebied in milliseconden (ms) wordt samen met de T1-curve in de
resultatentabel weergegeven. Als er meer dan 1 originele lokale ROI op de afbeelding is geplaatst, wordt het resultaat 
van het T1-lokale gemiddelde bijgewerkt.

3. Er kunnen maximaal 5 originele lokale ROI-metingen worden gemaakt op een afbeelding per tabblad.

4. Om een globale T1-analyse uit te voeren, selecteert u het originele LV-endocard  en volgt u de endocardiale 
grens.

5. Selecteer het originele LV-epicard  en volg de epicardiale grens. Het globale T1-resultaat wordt weergegeven 
in de resultatentabel.

T1-analyseprocedure na aankleuring

1. Om regionale T1-analyse uit te voeren, selecteert u de Post Local ROI-tool  en maakt u een interessegebied in 
het myocard.

2. Het Post Local T1-resultaat voor het gebied in milliseconden (ms) wordt weergegeven in de resultatentabel en de T1-
curve wordt weergegeven in de resultatentabel. Als er meer dan 1 Post Local ROI op de afbeelding is geplaatst, wordt
het resultaat van het T1-Post Local gemiddelde bijgewerkt.

3. Er kunnen maximaal 5 Post Local ROI-metingen worden gemaakt op een afbeelding per tabblad.

4. Om een globale T1-analyse uit te voeren, selecteert u het Post LV-endocard  en volgt u de endocardiale grens.

5. Selecteer het Post LV-epicard  en volg de endocardiale grens. Het globale T1-resultaat wordt weergegeven in 
de resultatentabel.
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Een parametrische kleurenkaart weergeven

OPMERKING:  Een lokale of globale ROI is vereist om een optie voor een parametrische kleurenkaart weer te geven.

1. Selecteer de juiste optie in het keuzemenu voor bestanden, zoals weergegeven in Afbeelding 2.

2. Klik op Grijstinten om parametrische kaartopties in grijstinten weer te geven.

FIGUUR 2. Kleurenkaartopties

ECV-kwantificatie 

1. Voer een lokale of globale T1-analyse uit voor zowel originele afbeeldingen als afbeeldingen na aankleuring.

2. Selecteer  voor originele afbeeldingen en plaats een ROI in de linker ventrikelholte.

3. Selecteer  voor afbeeldingen na aankleuring en plaats een ROI in de linker ventrikelholte.

4. Voer de Hematocrit-waarde (HCT) in.

5. Het ECV-resultaat (%) wordt weergegeven in de resultatentabel.

Referentie: Wong. et al,. „Association Between Extracellular Matrix Expansion Quantified by Cardiovascular Magnetic 
Resonance and Short-Term Mortality.” Circulation (2012):126:1206-1216.

Een polair diagram met 16 segmenten maken

OPMERKING:  Een ECV-polaire plot vereist dat de ECV-analyse is voltooid.

1. Voltooi de globale T1-analyse voor de tabbladen Basis, Midden en Apex.

2. Selecteer  voor originele afbeeldingen en plaats het RV-invoegpunt. 

3. Selecteer  voor afbeeldingen na aankleuring en plaats het RV-invoegpunt.

4. Selecteer het polair diagram met 16 segmenten .

5. Selecteer Grafieken  om terug te keren naar de T1-curven.
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Contouren verwijderen

Klik op  om contouren te wissen.

De T1-curven controleren 

1. De resultaten van de curveaanpassing tonen het signaalgedrag van de beeldgegevens. In geval van beeldartefacten
als gevolg van verkeerde registratie, ademhalingsartefacten of aritmieën is de curveaanpassing mogelijk niet
optimaal.

2. Een signaalintensiteitspunt kan uit de berekening worden geëlimineerd door direct op het punt in de grafiek te klikken 
en de contour te selecteren op de afbeelding die paars wordt.

3. Selecteer verwijderen met de rechtermuisknop (klikken en ingedrukt houden) of selecteer de delete-knop op het
toetsenbord.

WAARSCHUWING: Controleer de resultaten van de T1-curveaanpassing. De analyse moet worden uitgevoerd door 
een juist getrainde en gekwalificeerde gebruiker. 

Referentie: *Messroghli DR et al,. „Modified Look-Locker Inversion Recovery (MOLLI) for High Resolution T1 Mapping of 
the Heart.” Magnetic Resonance in Medicine (2004) 52: 141-146. 

Resultaat Vergelijkingsreferentie Type aanpassing

T1 Look-Locker 
(MOLLI) 

y=A-B exp(-t/T1*) Niet-lineaire curveaanpassing met een 
Levenberg-Marquardt-algoritme*
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T2-mappinganalyse
Deze functie maakt de signaalkwantificering van de T2-relaxatietijd mogelijk. T2-mapping is een weefselkarakteriseringstechniek.

Vereiste afbeeldingen: T2-voorbereidingsserie met een stabiele vrije precessie uitlezing met verschillende echotijden (TE). 
Representatieve plaklocaties voor basis, midden en apex van de linkerventrikel worden aanbevolen.

De berekening voor de T2-vervalcurve is: y = a exp(-TE/T2*) + c

Er zijn 2 correctiemethoden voor aanpassing - een aanpassing met 2 parameters waarbij de achtergrondruis c wordt 
berekend met behulp van een op histogrammen gebaseerd algoritme en afgetrokken van de signaalintensiteit, waarna een 
niet-lineaire aanpassing wordt uitgevoerd. De aanpassing met 3 parameters maakt gebruik van een niet-lineaire benadering.

WAARSCHUWING: De applicatie helpt alleen bij de analyse van de afbeeldingen en levert niet automatisch 
kwantificeerbare resultaten op. Het gebruiken en plaatsen van kwantitatieve metingen is 
aan de gebruiker. Onnauwkeurige metingen kunnen leiden tot verkeerde diagnoses. 
Metingen dienen alleen te worden verricht door goed opgeleid en gekwalificeerd personeel.

Start T2-mappinganalyse

1. Selecteer .

2. Selecteer de relevante T2-mappingserie.

3. Selecteer het juiste tabblad, Basis, Midden of Apex.

4. Selecteer de juiste korte as-plak uit de serielijst of het miniaturenpaneel.

5. Selecteer voor correctie van de aanpassing, een aanpassing met twee Parameters of een aanpassing met drie Parameters.

FIGUUR 1. T2-mappinganalyse
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Procedure voor T2-analyse

1. Om regionale T2-analyse uit te voeren, selecteert u de Local ROI tool  en creëert u een interessegebied in 
het myocard.

2. Het lokale T2-resultaat voor het gebied in milliseconden (ms) wordt samen met de T2-curve in de resultatentabel
weergegeven. Als er meer dan 1 lokale ROI op de afbeelding is aangebracht, wordt het resultaat van het T2-lokale
gemiddelde bijgewerkt.

3. Er kunnen maximaal 5 lokale ROI-metingen worden gecreëerd op een afbeelding per tabblad.

4. Om een globale T2-analyse uit te voeren, selecteert u het LV-endocard  en bakent u de endocardiale grens af.

5. Selecteer het LV epicard  en baken de epicardiale grens af. Het globale T2-resultaat wordt weergegeven in de 
resultatentabel.

Een parametrische kleurenkaart weergeven

Selecteer de juiste optie in het keuzemenu voor bestanden, zoals weergegeven in Afbeelding 2.

FIGUUR 2. Kleurenkaartopties

Een polair diagram met 16 segmenten maken

1. Voltooi de globale T2-analyse voor de tabbladen Basis, Midden en Apex.

2. Selecteer  voor het RV-invoegpunt. 

3. Selecteer het polair diagram met 16-segmenten .

4. Selecteer Grafieken  om terug te keren naar de T2-curven.
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Contouren verwijderen

Klik op  om contouren te wissen.

De T2-curven controleren 

1. De resultaten van de curveaanpassing tonen het signaalgedrag van de beeldgegevens. In geval van beeldartefacten
als gevolg van verkeerde registratie, ademhalingsartefacten of aritmieën is de curveaanpassing mogelijk niet
optimaal.

2. Een signaalintensiteitspunt kan uit de berekening worden geëlimineerd door direct op het punt in de grafiek te klikken 
en de contour te selecteren op de afbeelding die paars wordt.

3. Selecteer verwijderen met de rechtermuisknop (klikken en ingedrukt houden) of selecteer de delete-knop op het
toetsenbord.
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Tijdsduuranalyse 

Met de Tijdsduuranalysemodus heeft de gebruiker de mogelijkheid om myocardtijdsduurafbeeldingen te controleren en 
analyseren.

OPMERKING:  Semi-kwantitatieve analyse wordt ondersteund. Als een serie met dubbele reeks beschikbaar is, kan een 
functie voor schaduwcorrectie worden toegepast. 

VOORZICHTIG: Tijdsduurparameters van helling en relatieve helling zijn mogelijk niet nauwkeurig op beelden 
die schaduwcorrectie niet hebben uitgevoerd. 

WAARSCHUWING: De applicatie helpt alleen bij de analyse van de afbeeldingen en levert niet automatisch 
kwantificeerbare resultaten op. Het gebruiken en plaatsen van kwantitatieve metingen is 
aan de gebruiker. Onnauwkeurige metingen kunnen leiden tot verkeerde diagnoses. 
Metingen dienen alleen te worden verricht door goed opgeleid en gekwalificeerd personeel.

FIGUUR 1. Tijdsduuranalyse-Interface
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Tabel 1:  Analysetools

Propageer alle plakjes en alle fasen.

Propageer alle fasen; enkel plakje.

Voer autosegmentatie uit.

Analyse opnieuw berekenen na bewerking. (Alleen als automatische segmentatie is 
uitgevoerd.)

Contouren kopiëren/plakken over alle fasen. 

Analyse opnieuw berekenen na bewerking. (Alleen als kopiëren/plakken is uitgevoerd.)

Schaduwcorrectie toegepast, alleen beschikbaar voor een serie met dubbele reeksen.

Kleurenoverlay van Segment weergeven.

Geen overlay weergeven.

Pixelgewijze kleurenoverlay weergeven voor berekende parameter.

Grafiekweergave.

Tabel met parameterresultaten weergeven.

Selectie van Polair Diagram met 16 segmenten of concentrische polair diagram.

Kleurselectie in 2 kleuren, 4 kleuren of Continu Polair diagram.

Selecties uit Concentrisch polair diagram.
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Tijdsduuranalyse uitvoeren

1. Selecteer .

2. Selecteer het tabblad voor Stress of Rust.

3. Selecteer de myocardiale tijdsduurserie.

4. Selecteer  om berekening Automatische Segmentatie en analyse uit te voeren.

5. Controleer alle endocardiale en epicardiale sporen, RV-insteekpunt op elk segment en bewerk indien nodig.

6. Bevestig de basale, midden en apicale classificatie.

7. Als u handmatige segmentatie wilt uitvoeren, kies dan ervoor  om de endocardiale contour op een enkele 
plak of alle plakjes te tekenen.

8. Selecteer  om de epicardiale contour op een enkele plak of alle plakjes te tekenen.

9. Selecteer  om de contouren naar alle fasen te kopiëren/plakken.

10. Plaats het onderste RV-insteekpunt door  te selecteren.

11. Controleer alle endocardiale en epicardiale sporen, RV-insteekpunt op elk segment en bewerk indien nodig.

12. Bevestig de basale, midden en apicale classificatie.

13. Selecteer om de begin- en eindfase te kiezen.

14. Klik op  om de startfase toe te wijzen en klik vervolgens rechtstreeks op de cel in de matrix. 

15. Klik op  om de eindfase toe te wijzen en klik vervolgens rechtstreeks op de cel in de matrix.
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Contouren wijzigen

Wanneer een bewerking wordt uitgevoerd, moet de analyse opnieuw worden berekend. 

Het bewerkingswaarschuwingssymbool verschijnt. Klik op  om de herberekening uit te voeren.

Resultaten controleren: Polair Diagram met 16 segmenten

1. Selecteren om de berekende parameters te controleren in het vervolgkeuzemenu voor bestanden. Zie Figuur 2.

Door de cursor op een segment op het polaire diagram te plaatsen, wordt de bijbehorende grafiek voor dat 
segment gemarkeerd.

FIGUUR 2. Vervolgkeuzemenu Berekende Parameters

Grafiek-/Tabelresultaten controleren

1. Selecteren om grafiekresultaten te bekijken in het vervolgkeuzemenu voor bestanden, Figuur 3, linksonder in de
grafiekweergave.

2. Klik op  om de grafieken weer te geven.

Door de cursor direct op een gekleurd segment op de afbeelding te plaatsen, wanneer de segmentkleuroverlay 
op de afbeelding wordt weergegeven, wordt de bijbehorende grafiek voor dat segment gemarkeerd.

3. Klik op  om de parameterresultaten weer te geven.
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FIGUUR 3. Grafiekresultaten

Relatieve Helling (RU) en Reserve-Index (RI) berekenen

1. Selecteer  en plaats een ROI in de bloedpool op het basale plakniveau.

2. Klik met de rechtermuisknop en selecteer  om de bloedpool ROI te verwijderen

OPMERKING:  Voor de berekening van de gereserveerde index moet zowel Stress- als Rustanalyse aanwezig zijn.

VOORZICHTIG: Tijdsduurresultatenparameters van helling en relatieve helling zijn mogelijk niet nauwkeurig op 
beelden die schaduwcorrectie niet hebben uitgevoerd. 
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Definitie van parameters berekend uit de tijdsduurcurve 

Aankomsttijd tijd (in seconden) van het snijpunt van de basislijn en de helling

Piektijd tijd (in seconden) waarvan de signaalintensiteit het maximum bereikt 

SI-Ratio SI (piektijd - basislijn)/basislijn

Helling De helling wordt berekend door de gewogen lineaire aanpassing met behulp van 
punten tussen aankomsttijd en piektijd

Relatieve Helling RU = helling van de hartspier/helling van de bloedpool

Reserve-Index De myocardiale reserve-index (RU) wordt gedefinieerd als:
 RI = RU STRESS/RU RUST

Signaalintensiteit

Helling

Aankleuring

Baseline

Aankomsttijd Piektijd
Tijd
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Patent Foramen Ovale (PFO) -
analyse 

Met de PFO-analysetool kunnen om een vroege piek aan te tonen curves worden gemaakt waarin signaal tegen tijd wordt 
afgezet, zodat een PFO kan worden opgespoord. 

WAARSCHUWING: De applicatie helpt alleen bij de analyse van de afbeeldingen en levert niet automatisch 
kwantificeerbare resultaten op. Het gebruiken en plaatsen van kwantitatieve metingen is 
aan de gebruiker. Onnauwkeurige metingen kunnen leiden tot verkeerde diagnoses. 
Metingen dienen alleen te worden verricht door goed opgeleid en gekwalificeerd personeel.

PFO starten

1. Selecteer File (Bestand) > Select Analysis > PFO.

2. Selecteer een realtime-asserie.
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FIGUUR 1. PFO Analysevenster

1. PFO bewerkbare tabbladen, 2. Actieve ROI's, 3. Wissen, 4. Start- en eindfase, 5. Signaalintensiteit versus fasecurve, 6. PFO Analyse-iconen

Boezemanatomie selecteren

1. Selecteer een PFO-slice waarbij de anatomie van het linkeratrium (LA) en het rechteratrium (RA) kan worden gewaardeerd. 

Genereer Left Atrial (LA) intensiteitscurve

1. Selecteer  en teken de curve. 

2. Teken een contour op de RA in het Image Editor-venster.

3. Zet de cursor buiten het Image Editor-venster.

4. Een LA-intensiteitcurve maken.

De signaalintensiteitcurve voor de LA wordt automatisch aangemaakt.

Genereer Right Atrial (RA) intensiteitscurve

1. Maak de RA-intensiteitcurve op de hierboven beschreven wijze voor een LA-intensiteitcurve met behulp van .

1

3

5

6

2

4
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De curven worden over elkaar weergegeven in het curveresultatenvenster.

OPMERKING:  Als er bijvoorbeeld een ROI op fase 1 is geplaatst en de startfase is gewijzigd, blijft de door de gebruiker 
getekende ROI aanwezig op de oorspronkelijke afbeelding waar de ROI's zijn geplaatst.

FIGUUR 2. PFO-curveresultaten

 Bekijk curve-gegevens en selecteer fasebereik

1. Bekijk de curven in het rapportvenster en pas de Startfase en Eindfase aan.

2. Selecteer met de pijltjes omhoog en omlaag de Start Phase (Startfase) en End Phase (Eindfase) om het fasebereik in
te stellen voor een curve.

Het wijzigen van de start- en eindfasen heeft invloed op de weergave van de PFO-curven.

Door te klikken op een punt in het diagram, wordt de in het Image Editor-venster getoonde fase geüpdate.

FIGUUR 3. Start- en eindfasescherm

OPMERKING:  Als er voor een serie twee acquisities plaatsvinden, kunt u de start- en eindfase voor de eerste instellen, 
de LA- en RA-ROI's tekenen (zodat curven automatisch worden aangemaakt) en dan deze werkwijze 
herhalen op een andere PFO-tab voor de tweede set afbeeldingen. Alle PFO-tablabels zijn te wijzigen.



suiteHEART® Software-gebruiksaanwijzing NS-03-040-0008 Versie�1    124

Contouren wijzigen

Het wijzigen van meerdere fasen op een enkele schijflocatie:

1. Selecteer de schijflocatie

2. Selecteer

3. Selecteer de eerste fase van de te wijzigen reeks fasen.

4. Houd de shift-toets ingedrukt en selecteer de laatste fase van de te wijzigen reeks.

De geselecteerde thumbnails worden nu rood omlijst.

5. Wijzig de contour in het Image Editor-venster.

6. Deselecteer de contour door buiten de geselecteerde contour op de afbeelding te klikken of door de cursor buiten
het bewerkingsvenster te verplaatsen.

ROI-bewerking kan worden geregeld door het bereik in te stellen.

Selecteer de juiste scoopfunctie in de beeldweergave.

 Scope All - Past ROI-bewerkingen toe op alle fasen.

 Bereik tot einde - Past ROI-bewerkingen toe vanaf de huidige fase tot het einde.

 Scope Current Only - Past alleen ROI-bewerkingen toe op de huidige fase.

Contouren verwijderen

1. Klik op  om contouren te wissen.

Controle eindresultatencurve

Uit de contouren wordt een diagram aangemaakt waarin pixelintensiteit wordt afgezet tegen tijd. Klik met de 

rechtermuisknop op de diagram  om deze naar het rapport te verzenden.
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T2*

De T2*-analysetool berekent de T2*-waarden van weefsel uit een multi-echo snelle gradiënt echosequentie.

De T2*-curve is een grafiek van de signaalsterkte versus echotijd met een exponentiële vervalcurveformule. Het T2*-
pasalgoritme is gebaseerd op het niet-lineaire kleinste-kwadratenalgoritme van Levenberg-Marquardt.

De berekening van de T2*-vervalcurve is:   y = a *exp(-TE/T2*) + c

 Waar:

WAARSCHUWING: De applicatie helpt alleen bij de analyse van de afbeeldingen en levert niet automatisch 
kwantificeerbare resultaten op. Het gebruiken en plaatsen van kwantitatieve metingen is 
aan de gebruiker. Onnauwkeurige metingen kunnen leiden tot verkeerde diagnoses. 
Metingen dienen alleen te worden verricht door goed opgeleid en gekwalificeerd personeel.

y de signaalsterkte is op het moment TE

a de dwarse magnetisatie op tijdstip 0 (nul) is

TE de echotijd is

T2* de vervalconstante is en

c de achtergrondruis is
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Hartanalyseprocedure
FIGUUR 1. T2*-analyseweergave

1. Selecteer . 

2. Selecteer de relevante serie.

3. Selecteer de korte-asplak in het miniaturenpaneel.

4. Geef met behulp van  een contour aan dat het kamertussenschot omsluit.

De T2* en R2* worden berekend en worden weergegeven in de Tabel resultaten.

De waarde van R2 wordt berekend en weergegeven in de grafiek.
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Een myocard kleurmap maken

1. Teken met behulp van  een contour om de endocardrand.

2. Teken met behulp van  een contour om de epicardrand. 

De T2*-/R2*-kleurmap wordt over de afbeelding geplaatst. 

3. De van R2* kleurmapwaarde kan worden gewijzigd.

OPMERKING:  Het standaardbereik voor 1,5 T-afbeeldingen is 5 ms - 500 ms voor T2*. Het standaardbereik voor
3,0 T-afbeeldingen is 2,5 ms - 1.000 ms voor T2*. 

4. Klik en sleep omhoog of omlaag op pijltjes om het dynamische kleurbereik voor de kleurmap bij te stellen.

De kleuroverlay op de Image Editor verandert dynamisch.

De Hz- en ms-waarden veranderen eveneens dynamisch.

5. De T2*- en R2*-waarden kunnen worden bepaald door de  te selecteren en over de kleurmapoverlay op de 
afbeelding te plaatsen.
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Parameters aanpassen

Selecteer ofwel de 2 Parameter of de 3 Parameter Fit voor de T2*-vervalcurve. 

FIGUUR 2. Parameteraanpassing

De aanpassing van 2 parameters wordt algemeen aanvaard op basis van peer review literatuur [1]. In dit model wordt de 
achtergrondruis, c, berekend met behulp van een op histogrammen gebaseerd algoritme en afgetrokken van de 
signaalintensiteit, waarna een niet-lineaire aanpassing wordt uitgevoerd.

De aanpassing met 3 parameters is ook beschikbaar, zoals te lezen in peer review literatuur [2]. Dit model is een niet-
lineaire benadering die rechtstreeks op basis van het oorspronkelijke inputsignaal werkt.

Voor beide modellen wordt de initiële T2*-waarde geschat met behulp van een proef lineaire aanpassing.

1. D.J Pennell, et al. „Cardiovascular T2-star (T2Star) magnetic resonance for the early diagnosis of myocardial iron overload,” Eur Heart J 2001;
22: 2171-2179.

2. Ghugre NR, et al. „Improved R2* Measurements in Myocardial Iron Overload,” Journal of Magnetic Resonance Imaging 2006; 23: 9-16.

De T2*-resultaten controleren

1. Controleer de contourpositie op alle afbeeldingen.

2. De tabel toont de afzonderlijke T2*/R2*-metingen en berekent bovendien een gemiddelde.

Klik op  om contouren te wissen.

3. De optie om de resultaten van elke contour af te drukken kan worden gekozen door voor elke waarde in de Tabel
metingen de Afdrukinstelling te selecteren.

Controleer en update de T2*- curve

De T2*-curve is een grafiek van de signaalsterkte versus echotijd met een exponentiele vervalformule. T2*/R2*-waarden 
kunnen onnauwkeurig zijn als niet alle beelden beschikken over een voldoende signaal-tot-ruisverhouding (dwz 
signaalplateau naar bijna nul). 
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Om een enkele contour uit een afbeelding te verwijderen

1. Selecteer de contour zodat hij paars wordt.

2. Selecteer verwijderen in het rechtermuisknopmenu of gebruik de Delete-toets op het toetsenbord.

• De contour wordt verwijderd en het bijbehorende punt wordt uit de diagram gehaald.

FIGUUR 3. T2*-curve

WAARSCHUWING: Controleer de resultaten van de T2*-curveaanpassing. Een goed opgeleide en 
gekwalificeerde gebruiker dient analyse en diagnose uitvoeren.

R2*-/T2*-conversies

De factor 1000 wordt gebruikt als T2 en T2* in eenheden van milliseconden (ms) worden weergegeven en R2 en R2* in 

Hertz (of s-1) zijn.

Tabel 1:  

Resultaat Eenheid Conversie

R2* Hz R2*=1000/T2*

T2* ms T2*=1000/R2*



suiteHEART® Software-gebruiksaanwijzing NS-03-040-0008 Versie�1    130

3D/4D-viewer
3D/4D-viewer zorgt voor de visualisatie van 3D- en 4D Flow MRI-afbeeldingen. Het biedt hulpmiddelen voor het opnieuw 
formatteren en ondersteunt het maken van 2D-fasecontrastbeelden en 2D-functiebeelden van 4D Flow MRI-afbeeldingen 
die conventioneel kunnen worden geanalyseerd met suiteHEART® Software.

OPMERKING:  Een 3D-serie met isometrische voxels en overlappende schijven verbetert de kwaliteit van de 
geherformatteerde afbeeldingen.

OPMERKING:  De 3D/4D-analyse geeft een 4D-serie alleen weer als u voor 4D een licentie heeft.

VOORZICHTIG: 3D-afbeeldingen of geherformatteerde afbeeldingen bieden alleen aanvullende informatie bij 
het formuleren van een diagnose en moeten altijd worden gebruikt in combinatie met 
conventionele beeldvormingstechnieken.

WAARSCHUWING: Correleer een 3D-herformattering altijd met de originele acquisitiegegevens.

WAARSCHUWING: De instellingen voor vensterbreedte en niveau (WW/WL) kunnen het uiterlijk van 
verschillende pathologieën en het vermogen om andere anatomische structuren te 
onderscheiden, beïnvloeden. Onjuiste WW/WL-instellingen kunnen ertoe leiden dat de 
beeldgegevens niet worden weergegeven. Verschillende WW/WL-instellingen kunnen nodig 
zijn om alle beeldgegevens te bekijken.
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Onderdelen 3D/4D-viewer

FIGUUR 1. Beeldcontroletools en kijkvensters

Beeldcontroletools

3D-kijkvenster Axiaal kijkvenster

Schuin kijkvenster 1 Schuin kijkvenster 2
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Tabel 1:  Beeldcontroletools

Tool Beschrijving

Dradenkruiscursor - synchroniseert de navigatie tussen alle 
kijkvensters. 

Richtingsknoppen - veranderen het beeldvlak in de 3D en schuine 
kijkvensters.

S = Superior (Hoger)
I = inferior (Lager)
A = Anterior (Voorste) 
P = Posterior (Achterste) 
L = Links
R = Rechts 

Schuine modus - toont het vlak van de schuine herformattering en 
het loodrechte snijpunt om de gewenste anatomie weer te geven. 

Dubbele Schuine modus - toont drie schuine vlakken gedefinieerd 
door drie instelbare kleurassen - blauw, geel, groen. Pas een 
willekeurige as aan om de twee andere schuine vlakken bij te 
werken. 

3D-weergavemodus - biedt beeldweergavemodi in het 3D-
kijkvenster

Oppervlak 
MIP = maximale intensiteitsprojectie (standaard)
MINIP = Minimale intensiteitsprojectie 

Stroomlijnen - Visualiseer 3D-snelheidsvelden in een specifieke 
tijdsfase.

Kleuroverlay - schakelt de kleuroverlay in/uit. Alleen beschikbaar 
voor 4D Flow-afbeeldingen.

Fase - schakelt tussen de afbeeldingsweergave van grootte en fase.
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Bloedstroomsnelheid - past de kleurtoewijzing van de 
stroomrichting aan. 
Alleen beschikbaar voor 4D Flow-afbeeldingen.
De kleurenbalklegenda voor de bloedstroomsnelheid wordt aan de 
rechterkant van elk kijkvenster weergegeven. De waarde is een 
schatting.

Kleurdekking - regelt de kleurdekking op de afbeelding om de 
visualisatie van de onderliggende anatomie te verbeteren. Alleen 
beschikbaar voor 4D Flow-afbeeldingen. 

Cine - regelt frames per seconde en definieert het begin- en 
eindframe van de film. Alleen beschikbaar voor 3D-
tijdgeresolveerde magnitude- en 4D Flow-afbeeldingen. Gebruik de 
spatiebalk op het toetsenbord om film af te spelen of te pauzeren.

Seriedefinitie - maakt conventionele 2D-functionele afbeeldingen 
of een serie stroomafbeeldingen voor analyse of nabewerkte MIP-
afbeeldingen. Gebruiken om het aantal plakjes, de plakdikte, de 
tussenruimte en het beeldveld in te voeren. Deze parameters zijn in 
de linkerbovenhoek van elk kijkvenster geannoteerd. Gebruik Ctrl + 
T om aan/uit te schakelen.

Alleen magnitude - maakt een magnitudeserie van enkele of 
meerdere plakjes met meerdere fasen van de originele 
afbeeldingen voor gebruik bij functieanalyse.

Magnitude en fase - maakt een magnitude- en faseserie van enkele 
of meerdere plakjes met meerdere fasen van de originele 
afbeeldingen voor gebruik bij stroomanalyse. Deze optie is alleen 
beschikbaar wanneer een 4D Flow-serie is geselecteerd. (Er wordt 
ook een dubbele serie gemaakt die automatisch in fase wordt 
gecorrigeerd.)

Nabewerkt - creëert projectiebeelden met maximale intensiteit van 
3D-beelden. Wanneer er 4D Flow-gegevens aanwezig zijn, worden 
voor de beoordeling series van enkele of meerdere plakjes in 
meerdere fasen met kleuroverlay op de afbeeldingen gemaakt. 

Opslaan - slaat alle afbeeldingsreeksen die door de seriedefinitie 
zijn gemaakt, op in de lokale database. 

Tabel 1:  Beeldcontroletools

Tool Beschrijving
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Rx-planning - definieert de gewenste scanvlakas gemaakt door 
seriedefinitie. 

Bladeren en indikken - wijzigt de dikte van de MIP-afbeelding en 
bladert door de afbeeldingenset. 

1 = klik en sleep beide zijknoppen om de dikte van de MIP-
afbeelding te wijzigen
2 = klik en sleep de schuifregelaar om door de afbeeldingenset te 
bladeren. 

Besturingselementen bevinden zich aan de rechterkant van het 
geselecteerde kijkvenster.

Lineair - Verstrekte afmeting van de afstand van een rechte lijn. Klik 
precies op de afmeting en klik vervolgens met de rechtermuisknop 
om te Verwijderen, Lokaliseren of Labelen.

3D-Roteren - kantelt of roteert de afbeeldingen in het 3D-
kijkvenster en/of de schuine kijkvensters 1 en 2. Klik met de 
linkermuisknop en sleep rechtstreeks in het kijkvenster om te 
kantelen of roteren. 

Stroomrichting - geeft het loodrechte vlak weer in de schuine 
kijkvensters 1 en 2. Klik met de linkermuisknop rechtstreeks op het 
relevante lichaamsdeel om deze functie te gebruiken. Alleen 
beschikbaar voor 4D Flow-afbeeldingen.

Venster/Niveau - beschikbaar in alle kijkvensters.

Zwenken - beschikbaar in alle kijkvensters.

Inzoomen - beschikbaar in alle kijkvensters.

Tabel 1:  Beeldcontroletools

Tool Beschrijving
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Roteren - beschikbaar voor het 3D-kijkvenster, kijkvenster 1 en 
kijkvenster 2.

Resetten - beschikbaar in alle kijkvensters.

Parameters scannen - beschikbaar in alle kijkvensters.

Tabel 2:  Sneltoets

Functie Actie

Doelcursor Druk op de Shift-toets en verplaats de draadkruiscursor 
naar het gewenste lichaamsdeel.

Tabel 1:  Beeldcontroletools

Tool Beschrijving
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3D/4D-viewerindeling en seriecreatie-uitvoer

Afhankelijk van het type afbeeldingsreeksen dat is geselecteerd voor herformattering, wordt het type beeldvorming samengevat in de 
onderstaande tabel. 

Werkstroomvoorbeeld: Maak MIP-afbeeldingen van een 3D-afbeeldingenserie

1. Selecteer het juiste onderzoek en start de suiteHEART® Software.

2. Selecteer .

3. Selecteer de juiste 3D-serie in het keuzemenu serienavigatie. Het geselecteerde afbeeldingstype wordt op de knop
aangegeven, zoals weergegeven inFiguur 2.

FIGUUR 2. Serienavigatie

Tabel 3:  3D/4D-indelingen en uitvoer

3D/4D-viewerindeling 3D-afbeeldingenserie-uitvoer 4D Flow-afbeeldingenserie-uitvoer

3D-weergave (kijkvenster 
linksboven)

Nabewerkt Nabewerkt

Axiaal (kijkvenster rechtsboven) Alleen omvang

Nabewerkt (MIP)

Alleen omvang*, omvang en fase* en 
nabewerkt (kleuroverlay)*

Schuin 1 (kijkvenster linksonder) Alleen omvang

Nabewerkt (MIP)

Alleen omvang*, omvang en fase* en 
nabewerkt (kleuroverlay)*

Schuin 2 (kijkvenster 
rechtsonder)

Alleen omvang

Nabewerkt (MIP)

Alleen omvang*, omvang en fase* en 
nabewerkt (kleuroverlay)*

*Dit serietype kan worden gebruikt voor conventionele analyse in suiteHEART® Software

Voor elke omvang- en faseserie wordt een duplicaatserie gemaakt die automatisch in fase wordt gecorrigeerd.
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4. Selecteer de  en klik op het gewenste kijkvenster. Het actieve kijkvenster wordt rood gemarkeerd. De gele 
lijnen voor opnieuw formatteren verschijnen zoals weergegeven in Figuur 3. 

FIGUUR 3. Schuine modus

5. Klik op de ononderbroken gele lijn, klik met de linkermuisknop en sleep en kantel de lijn om het gewenste
lichaamsdeel weer te geven.

a.) Klik op het gewenste kijkvenster om op te slaan. 

b.) Pas de MIP-dikte aan met behulp van de bedieningselementen aan de rechterkant van het kijkvenster. 

c.) Voltooi de invoergegevens voor seriedefinitie, zoals weergegeven in figuur 4. 

d.) Klik op de knop Opslaan om de MIP-afbeelding op te slaan in de lokale database.

FIGUUR 4. Seriedefinitie

1. Selecteer Nabewerkt

2. Klik op Opslaan
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6. Maak een stapel MIP-afbeeldingen door  te selecteren.

OPMERKING:  Het maximale aantal nabewerkte MIP-afbeeldingen dat kan worden gemaakt, is 512.

7. Klik op het kijkvenster dat als referentieafbeelding moet worden gebruikt en definieer een stapel batchafbeeldingen,
zoals weergegeven inFiguur 5.

a.) Vergroot het plakbereik.

b.) Pas de hoek aan en pijlen geven de richting van de plak aan.

c.) Verplaats de Rx.

FIGUUR 5. Rx-planning

8. Voer de seriedefinitie-opties in en klik op  om de stapel afbeeldingen in de lokale database op te slaan. 

9. Om de gemaakte serie te bekijken, schakelt u over naar de functieanalysemodus, selecteert u de beoordelingsmodus
en klikt u op Vernieuwen.

Werkstroomvoorbeeld: Maak een 2D-serie voor conventionele analyse

Voor het creëren van conventionele 2D-fasecontrast afbeeldingen en 2D-functionele afbeeldingen is een 4D Flow-serie 
vereist met zowel tijdgeresolveerde magnitudeconventies als stroomconventies van R/L, A/P en S/I. 

Series gemaakt als magnitude alleen of magnitude en fase uit 4D flow-beelden zijn een geldige conventionele 2D-serie die 
kan worden gebruikt in functie- of stroomanalyse.

Series die zijn gemaakt als nabewerkingen van 4D Flow hebben een overlay met kleurenstromen. Als het juiste scanvlak 
wordt gecreëerd, kan de serie worden gebruikt voor functieanalyse.

a a

b

c
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1. Selecteer het juiste onderzoek en start de suiteHEART® Software.

2. Selecteer .

3. Selecteer de juiste 4D-serie in het keuzemenu Serienavigatie, zoals weergegeven inFiguur 6. Het geselecteerde
afbeeldingstype wordt op de knop aangegeven, zoals weergegeven inFiguur 6.

FIGUUR 6. Serienavigatie

4. Selecteer de  en klik op het gewenste kijkvenster. Het actieve kijkvenster wordt rood gemarkeerd. De gele 
lijnen voor opnieuw formatteren verschijnen zoals weergegeven inFiguur 7.

FIGUUR 7. Schuine modus 4D herformatteren

5. Klik op de ononderbroken gele lijn, klik met de linkermuisknop en sleep en kantel de lijn om het gewenste
lichaamsdeel weer te geven.

a.)  Klik op het gewenste kijkvenster om op te slaan en selecteer de modus Magnitude en fase om een 2D-
fasecontraserie te maken of selecteer Magnitude om een functionele serie te maken. 

b.) Pas de plakdikte aan met behulp van de bedieningselementen aan de rechterkant van het kijkvenster. 

c.) Voltooi de invoergegevens van de seriedefinitie, zoals weergegeven in figuur 8, en klik op de knop Opslaan om 
de serie op te slaan in de lokale database.
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FIGUUR 8. Seriedefinitie en opslaan

6. Selecteer  om een stapel met meerdere plakken uit meerdere fasen te maken.

OPMERKING:  Het maximale aantal afbeeldingen uit meerdere fasen dat kan worden gemaakt, is 32.

OPMERKING:  Als een 2D-magnitude- en faseserie wordt gecreëerd met behulp van de 3D/4D-viewer, maakt de
applicatie een automatische fase gecorrigeerde duplicaatserie. De serie krijgt het label „gecorrigeerd”, 
zoals weergegeven in Figuur 9.

FIGUUR 9. Voorbeeld van automatische fase gecorrigeerde duplicaatserie

1. Selecteer Magnitude en Fase

2. Klik op Opslaan
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7. Klik op het kijkvenster dat als referentieafbeelding moet worden gebruikt en definieer een stapel batchafbeeldingen,
zoals weergegeven in Figuur 10.

FIGUUR 10. Rx-planning

8. Selecteer de seriedefinitie-opties in en klik op  om de stapel afbeeldingen in de lokale database op te slaan. 

9. Om de gemaakte serie te analyseren, schakelt u over naar de juiste analysemodus en klikt u op Vernieuwen.

Werkstroomvoorbeeld: Maak een Stroommeting

Voor gedetailleerde informatie over de interface-tools voor stroomanalyse, zie Stroomanalyse op pagina 79.

1. Selecteer het Tabblad Analyse.

2. Lokaliseer het betreffende bloedvat. Alleen anatomie van de aorta of de longvaten wordt ondersteund voor de

versterkte autosegmentatie zoals weergegeven. Klik op de  om een stroomcurve te genereren.
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FIGUUR 11. Voorbeeld Aorta en Longvaten

WAARSCHUWING:  Het gebruik van Versterkte automatische segmentatie vereist een zorgvuldige beoordeling 
van alle resultaten. Als de bloedvatidentificatie niet optimaal is, voer dan een conventionele 
automatische segmentatie voor het bloedvat uit.

3. Lokaliseer voor conventionele autosegmentatie het betreffende bloedvat en klik op de  zoals getoond in Figuur 12.

Er zijn zes ROI's beschikbaar, genummerd 1 - 6. De kleurcode is hetzelfde in de analyseweergave, afbeeldingkijkvensters en 
diagrammen.

4. Creëer een contour rond een bloedvat door 4 punten rond het betreffende vat te plaatsen en op het laatste punt te
dubbelklikken om de ROI af te bakenen.

5. Klik op  voor automatische segmentatie voor alle fasen in de plak.

FIGUUR 12. Handmatige ROI-Plaatsing
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Voer Correctie van Snelheidsaliasing uit

Versleep de schuifregelknop om phase unwrapping uit te voeren om te corrigeren voor snelheidsaliasing. Het effect van 
de wijziging wordt direct op het fasebeeld bijgewerkt en de resultaten worden direct in de stroomdiagram weergegeven. 
Om elk van de drie snelheidsgecodeerde afbeeldingen langs de drie orthogonale (x, y, z) richtingen te controleren, moet u 
een keuze maken in het vervolgkeuzemenu zoals getoond in Figuur 13.

FIGUUR 13. 
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Gestructureerd rapporteren

Rapportinhoud definiëren

De metingen en diagrammen in de rapporten worden opgesteld op basis van de resultaten van de analysemodi. Elk 
afzonderlijk analyseresultaat kan worden geselecteerd voor opname in het rapport.

Vooraf gedefinieerde klinische indrukken en technieken stroomlijnen zelfgedefinieerde rapporten. Zie ook paragraaf 
Tabblad Indruk voor procedurele details over het aanmaken van klinische indrukken en technieken. Met Report 
Preferences (Rapportvoorkeuren) kunt u site-informatie invoegen die als titels en kopjes in het patiëntrapport zullen 
komen.

Gestructureerde rapportweergave

De gestructureerde rapportweergave helpt bij het aanmaken van klinische rapporten. Er zijn vier tabbladen:

• Geschiedenis
• Indruk
• Afbeeldingen
• Poolcoördinaten

Elk af te drukken veld is gekoppeld aan een selectievakjewisseltoets . Klik op het selectievakje om het veld in het 
rapport op te nemen of eruit te laten.

OPMERKING:  Afdrukselecties kunnen worden geconfigureerd op het tabblad Afdrukvoorkeuren onder Tools > 
Preferences (Voorkeuren) > Edit Preferences (Voorkeuren bewerken).

Tabblad Geschiedenis 

Het tabblad Geschiedenis bevat patiëntinformatie uit de DICOM-titel. Bij het wijzigen van informatie wordt het veld geel 
gemarkeerd.

OPMERKING:  Gewijzigde patiëntinformatie heeft alleen invloed op het rapport. De DICOM-titel blijft intact.
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FIGUUR 1. Tabblad Geschiedenis

1. DICOM-titelinformatie, 2. BSA-selectie, 3. Patiëntgeschiedenis, 4. Opmerkingen 

Het BSA-berekeningstype kan worden geselecteerd door met de rechtermuisknop op de omgekeerde gele driehoek te klikken.

Referentie: http://halls.md/formula-body-surface-area-bsa/

BSA-berekeningsmethode Formule

DuBois en DuBois BSA (m2) = 0,20247 x Hoogte (m)0,725 x Gewicht (kg)0,425

Mosteller BSA (m2) = SQRT ([Hoogte (cm) x Gewicht (kg)]/3600)
BSA (m2) = SQRT ([Hoogte (cm) x Gewicht (pond)]/3131)

Gehan en George BSA (m2) = 0,0235 x Hoogte (cm)0,42246 x Gewicht (kg)0,51456

Haycock BSA (m2) = 0,024265 x Hoogte (cm)0,3964 x Gewicht (kg)0,5378

Boyd BSA (m2) = 0,0003207 x Hoogte (cm)0,3 x Gewicht (gram)(0,7285 - (0,0188 x LOG (gram))

1

2

3

4
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Tekstvakken voor Geschiedenis en Opmerkingen

Voer in het veld Geschiedenis alle informatie in die relevant is voor de patiëntgeschiedenis of selecteer de juiste macro. 
Het deelvenster Notities geeft de notities weer die door de gebruiker zijn ingevoerd tijdens de analyse, maar zijn niet 
beschikbaar voor opname in het rapport.

Tabblad Indruk 

FIGUUR 2. Tabblad Indruk

1. Indruk, 2. Techniek

Indruk 

Voer informatie over indrukken in door in het tekstvakje te typen en/of te klikken op een indrukkenmacrotoets.

Vooraf gedefinieerde indrukkenmacro's bevinden zich op toetsen onder het Indrukkenpaneel. 

OPMERKING:  Alle geschikte analyses moeten worden uitgevoerd voordat resultaatberekeningen worden gemaakt 
met macro's.

Techniek 

Voer techniekinformatie in door in het tekstvakje te typen en/of te klikken op een techniekmacrotoets.

Vooraf gedefinieerde techniekmacro's bevinden zich op toetsen onder het Techniekpaneel. 

OPMERKING:  Alle geschikte analyses moeten worden uitgevoerd voordat resultaatberekeningen worden gemaakt 
met macro's.

1

2
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Tabblad Afbeeldingen 

FIGUUR 3. Tabblad Afbeeldingen   

1. Grafieken/Tabellen, 2. Afbeeldingen voor het rapport

2

1
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Diagrammen en overzichtstabellen voor het rapport controleren

Het paneel Diagrammen bekijken bevat alle diagrammen en overzichtstabellenresultaten die zijn opgenomen in het 
rapport tijdens de analyse.

1. Ga met behulp van de -iconen door elke diagram en overzichtstabel.

2. Klik in het witte tekstvak om een bijschrift voor een grafiek of samenvattende tabel toe te voegen voor het afgedrukte 
rapport.

3. Als  is ingeschakeld, wordt de grafiek of tabel in het rapport opgenomen.

4. Klik op  om een grafiek of tabel te verwijderen.

Afbeeldingen controleren

Het Afbeeldingenpaneel bevat alle afbeeldingen die tijdens de analyse naar het rapport zijn gestuurd.

1. Ga met behulp van het -icoon door elke afbeelding.

2. Klik in het witte tekstvak om een bijschrift voor een afbeelding toe te voegen voor het afgedrukte rapport.

3. Selecteer de afbeeldingsgrootte door de kleinformaat-  of grootformaat -toetsen te kiezen.

4. Afbeeldingen in het afbeeldingspaneel kunnen opnieuw worden gerangschikt door op de afbeelding te klikken en
deze naar een ander kijkvenster te slepen.

5. Klik met de rechtermuisknop op een afbeelding om toegang te krijgen tot de hulpmiddelen voor het bewerken van
afbeeldingen.

6. Klik met de rechtermuisknop op de afbeelding en selecteer de knop  lokaliseren om de reeks te vinden waaruit 
de afbeelding afkomstig is.

7. Als  is ingeschakeld, wordt de afbeelding in het rapport opgenomen.

8. Verwijder een afbeelding door  te selecteren.

OPMERKING:  Als een onderzoek wordt geopend dat is geanalyseerd vanuit een eerdere softwareversie (2.1.0 of 
lager), kunnen afbeeldingen die eerder zijn toegevoegd aan de rapportweergave niet worden bewerkt 
met behulp van de beeldmanipulatietools. Nieuwe toegevoegde afbeeldingen kunnen worden 
gemanipuleerd zoals verwacht.



suiteHEART® Software-gebruiksaanwijzing NS-03-040-0008 Versie�1    149

Tabblad Poolcoördinaten

Deze tabel maakt de identificatie mogelijk van functionele, myocardiale evaluatie en tijdsverloopafwijkingen kwalitatief in 
een polair plotformaat. Als u de kleurcodering van de segmenten wilt wijzigen, klikt u met de rechtermuisknop op de 
kleurlegenda's van het segment om het kleurenpalet te openen.

FIGUUR 4. Tabblad Polaire plot

Polaire plots toevoegen aan rapport

Als u extra polaire plots aan het rapport wilt toevoegen, klikt u op  en selecteert u het polaire plottype in het 

vervolgkeuzemenu Bestand .
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Kleuren per segment selecteren

Klik op het kleurvak naast de gewenste terminologie om de afwijking te beschrijven. De cursor verandert in een penseel. 
Klik vervolgens op het segment direct op de polaire plot om de kleur in te stellen. 

Kleuren selecteren voor alle segmenten

Klik met de rechtermuisknop buiten de polaire plotomtrek in de hoeken en maak de gewenste selectie uit de lijst. 

FIGUUR 5. Selectie voor functie

16- of 17-segmentenplots selecteren

Selecteer het juiste keuzerondje links van de polaire plot.

De titel van de polaire plot bewerken

De typetitel van elke polaire plot kan worden bewerkt door in het invoerveld te klikken.

FIGUUR 6. Bewerk het invoerveld voor de titel van de polaire plot

Een polaire plot verwijderen

Elke plot kan van het tabblad worden verwijderd door op de knop  te klikken. Schakel het selectievakje uit om de 
polaire plot uit te sluiten van het rapport. 

FIGUUR 7. Sluit de polaire plot uit van het rapport

Selecteer  om de polaire plot terug te zetten naar standaard.
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Het rapport vooraf bekijken  

1. Selecteer Bestand > Voorbeeldrapport of selecteer  rechtsonder.

2. Controleer het rapport om ervoor te zorgen dat alle gewenste analyseresultaten en gestructureerde informatie is
opgenomen.

3. Selecteer  om het rapport op te slaan op de lokale harde schijf. 

Met het keuzemenu Save (Opslaan) kunnen de bestemming, naam en formaatopties van het rapport worden 
gedefinieerd.

OPMERKING:  De naam van het rapportbestand kan worden geconfigureerd in Preferences (Voorkeuren). Zie Procedure 
rapportvoorkeuren op pagina 30.

BELANGRIJK: Waarden die in rood worden weergegeven, vallen buiten het bereik, wat niet duidelijk zal zijn als het 
rapport op een zwart-witprinter wordt afgedrukt. 

FIGUUR 8. Opslaan-venster

4. Selecteer Print (Afdrukken) om het rapport af te drukken.

WAARSCHUWING: Het rapport moet voor goedkeuring en distributie worden gecontroleerd om ervoor te 
zorgen dat de inhoud overeenstemt met de analyse. Onjuiste rapportinhoud kan leiden tot 
een vertraagde of verkeerde diagnose. Analyse en interpretatie dient te worden uitgevoerd 
door goed opgeleid en gekwalificeerd personeel.

Het onderzoek goedkeuren 

De applicatie bevat een functie om rapporten goed te keuren en af te sluiten. Het goedgekeurde rapport wordt 
opgeslagen en kan worden bekeken maar niet veranderd.

OPMERKING:  Voorwaarden: De gebruiker moet een geautoriseerde rapportondertekenaar zijn. Zie Geautoriseerde 
Rapportbekrachtigers op pagina 31.
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OPMERKING:  De knop „Goedgekeurd onderzoek” en het menu worden pas ingeschakeld als er een actie op een 
afbeelding is uitgevoerd. 

1. Selecteer Onderzoek goedkeuren of selecteer Bestand > Onderzoek goedkeuren.

FIGUUR 9.        Venster Onderzoek goedkeuren

2. Voer, indien gewenst, een beschrijving van de ondertekening in.

3. Selecteer uw naam in het keuzemenu Naam.

4. Typ uw wachtwoord.

5. Klik op Approve (Goedkeuren) om te bevestigen en het venster te sluiten. Klik op Cancel (Annuleren) om het venster
te sluiten zonder de ondertekenprocedure te voltooien.

Met behulp van de gegeven beschrijving wordt een serie gemaakt.

OPMERKING:  Wanneer een goedgekeurd onderzoek is uitgevoerd, krijgt het rapport de datum- en tijdstempel.
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Exportopties

Met de exportfunctie kunnen voor toekomstige beoordeling back-ups worden gemaakt van de onderzoeken en de 
analyseresultaten. Met de exportfunctie kunt u niet-gecomprimeerde .avi-films, gecomprimeerde QuickTimefilms, GIF, JPEG, 
TIFF en PNG-bestanden van de afbeeldingen maken. Deze bestanden kunnen naar het bestandssysteem worden geschreven. 

Selecteer Tools > Export (Exporteren) > Export Report (Rapport exporteren).

Een secundaire opname (SCPT) wordt gemaakt en opgeslagen in de serielijst.

Selecteer Tools > Export (Exporteren) > Export Report (Rapport exporteren) naar Excel.

Exporteert een rapport als een Excel-bestand.

Selecteer Tools > Export (Exporteren) > Export Cine DICOM (Film-DICOM exporteren).

Een secundaire opname (SCPT) wordt gemaakt en opgeslagen in de serielijst.

Selecteer Tools > Export (Exporteren) > Export Cine Files (Filmbestanden exporteren).

Nu wordt het pop-upvenster Film opslaan getoond.

Selecteer Tools > Export (Exporteren) > Export Report (Rapport exporteren) naar XML

Exporteert een rapport als een XML-bestand.

Selecteer Tools > Exporteren > Exporteren naar Matlab (alleen licentie).

Exporteert een Mat-bestand in binaire vorm.

FIGUUR 10. Venster Film opslaan

1. Selecteer de te exporteren bestandstypen.

2. Blader naar de locatie waar u het bestand (de bestanden) wilt opslaan.

3. Klik op Save (Opslaan) om het exporteren te starten en het venster te sluiten. De actueel bekeken serie is het enige
bestand dat wordt geëxporteerd.

OPMERKING:  Bij het exporteren van gegevens naar AVI- of MOV-bestanden stelt suiteHEART® Software de maximale 
framesnelheid per seconde in op 20 frames per seconde, ongeacht de instellingen die worden gebruikt 
voor het bekijken binnen de applicatie.

OPMERKING:  Als u een aangepaste serie met zowel meerfasige als eenfasige afbeeldingen exporteert als een .avi- of 
.mov-bestand, zorg er dan voor dat een kijkvenster met een meerfasige afbeelding is geselecteerd 
voordat u exporteert.
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Een goedgekeurd rapport controleren 

1. Select File (Bestand) > Load Approved Exam (Goedgekeurd onderzoek laden).

Nu wordt het venster Goedgekeurd onderzoek selecteren getoond. Alle goedgekeurde onderzoeken betrekking 
hebbende op het onderzoek worden in de lijst weergegeven.

FIGUUR 11.       Venster Selectie goedgekeurde onderzoeken

2. Selecteer de serie in de lijst.

3. Klik op Load (Laden) om het goedgekeurde onderzoek en de bijbehorende analyse te laden en tonen.

• Een goedgekeurd onderzoek kan alleen worden bekeken.
• Een nieuw onderzoek kan worden aangemaakt op basis van een goedgekeurd onderzoek door dat te wijzigen en de

veranderingen in een nieuw onderzoek op te slaan. Het nieuwe onderzoek wordt opgeslagen als een secundaire-
opnameserie.

OPMERKING:  Als een goedgekeurd onderzoek en analyse wordt geladen, wordt de informatie in de actuele 
analysesessie overgeschreven.

OPMERKING:  Bij het herstellen van examens die zijn geanalyseerd met eerdere versies van suiteHEART® Software en 
als een „Load Approved Exam” (Goedgekeurd onderzoek laden) is uitgevoerd, heeft het rapport niet de 
naam van de goedkeurder of de datum- en tijdstempel. Het wordt aanbevolen om alle analyses te 
controleren en alle resultaten te bevestigen voordat het rapport opnieuw wordt uitgegeven.
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Rapportdatabase

Met de tool rapportdatabase kunt u zoeken in de inhoud van eerder goedgekeurde rapporten. Een rapport wordt pas in de 
rapportdatabase opgenomen als het is goedgekeurd.

FIGUUR 1. Rapportdatabase Venster

1. Vervolgkeuzemenu zoeksjabloon, 2. Geschiedenisbalk, 3. Maak zoekopdrachtvelden, 4. Zoekopdrachtresultaten, 5. Nieuw-knop

3
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Procedure tool rapportdatabase

Het rapportdatabasevenster openen

1. Selecteer Tools > Report Database (Rapportdatabase).

Selecteer Zoekcriteria

1. Selecteer de juiste sjabloon voor de zoekopdracht uit het keuzemenu Sjabloon zoeken.

2. Selecteer de zoekopdracht uit het keuzemenu Geschiedenis. De actuele opdrachtbalk toont uw geselecteerde
waarden.

FIGUUR 2. Menu Sjabloon zoeken

OPMERKING:  Maak als de gewenste zoekopdracht nog niet bestaat een nieuwe.

Een zoekopdracht maken

1. Selecteer New (Nieuw) rechts van de Geschiedenisbalk.

Nu worden de maak-zoekopdrachtpanelen getoond in het rapportdatabasevenster.
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FIGUUR 3. Paneel Zoekopdracht maken

1. Zoekopdracht-operators, 2. Zoekopdracht operanden, 3. Tabbladen zoekopdrachtcategorie, 4. Zoekopdrachtgroep, 5. Zoekopdrachtvelden,
6. Zoekopdrachtregels, 7. Zoekopdrachtopties, 8. In bedrijf-knop, 9. Knop Toevoegen, 10. Nieuw-knop

2. Selecteer de tab zoekopdrachtcategorie uit Onderzoek, Functie, ME en T2*. De zoekopdrachtgroepen en -velden
worden navenant bijgewerkt.

3. Selecteer de zoekopdrachtgroep.

4. Selecteer het zoekopdrachtveld.

OPMERKING:  De rapportdatabase kan geen zoekopdracht uitvoeren op zelfgedefinieerde metingen.

5. Selecteer de operator om de zoekopdrachtparameters te definiëren.

6. Voer de operand(en) in om waarden te geven voor de zoekparameters.

7. Selecteer Add (Toevoegen) om de zoekopdrachtwaarden te tonen in het Rules (Regels) -paneel. Tijdens een enkele
zoekactie kunnen meerdere zoekopdrachten worden uitgevoerd. Herhaal stappen 1-7 voor elke extra regel.

De Not (Niet) -toets zal een zoekwaarde tenietdoen.

De Or (Of) -toets zal meerdere zoekopdrachten koppelen terwijl de zoekopdracht wordt afgerond met een van de 
zoekopdrachten. De Or (Of) -functie geldt voor de zoekopdrachtregel boven de selectie.

De Delete (Verwijderen) -toets biedt de mogelijkheid een zoekopdrachtregel te selecteren en verwijderen.

1 2

3

4
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De zoekactie activeren

1. Selecteer Run (Starten) om in de database te zoeken.

De resultaten worden getoond in het gebied Resultaat zoekopdracht. De zoekopdrachtwaarden die de zoekactie 
afronden worden getoond in de meest rechtse kolom van het resultatenvenster.

FIGUUR 4. Venster zoekopdrachtresultaten

1. Geschiedenisbalk, 2. Zoekopdrachtresultaten, 3. Knop Lijst afdrukken, 4. Knop rapporten afdrukken, 5. Knop Lijst exporteren, 6. Verwijderen-knop

OPMERKING:  Nieuwe zoekopdrachtresultaten worden alleen aangemaakt op basis van een unieke combinatie van
onderzoekidentificatienummer, onderzoeksdatum, geautoriseerde ondertekening en rapportsjabloon. 
Als een duplicaat van deze velden wordt gevonden, wordt het oude rapport vervangen door het nieuwe.

Resultaten bekijken

1. Dubbelklik om een rapport te bekijken op een ingang in het gebied Zoekopdrachtresultaten.

Nu opent een nieuw venster met het geselecteerde rapport. Ga als er meerdere rapporten beschikbaar zijn met 
behulp van Next Report (Volgend rapport) en Previous Report (Vorig rapport) van het ene naar het andere 

rapport. Klik op de marker Venster sluiten  om het rapportcontrolevenster te sluiten.

1

2 3

4

5

6
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FIGUUR 5. Het rapportvenster

2. Gebruik de selectieopties in het Wijzigenmenu om de geselecteerde resultaten aan te passen:

Edit (Wijzigen) > Select All (Alles selecteren) selecteert alle zoekresultaten.

Edit (Wijzigen) > Clear Selection (Selectie verwijderen) deselecteert alle zoekresultaten.

Edit (Wijzigen) > Invert Selection (Omgekeerde selectie) keert de selectie van de zoekresultaten om.

Edit (Wijzigen) > Clear History (Geschiedenis verwijderen) verwijdert de lijst van vorige zoekopdrachten.

3. Selecteer Print List (Lijst afdrukken) om een lijst van zoekopdrachten naar de printer te sturen.

4. Selecteer Print Reports (Rapport afdrukken) om de geselecteerde rapporten naar de printer te sturen.

5. Selecteer Export List (Lijst exporteren) om de lijst op te slaan als een html-bestand.

6. Selecteer Delete (Verwijderen) om het (de) geselecteerde rapport(en) uit de rapportdatabase te verwijderen.
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Een zoekopdracht opslaan

1. Selecteer Favorites (Favorieten) > Add to Favorites (Aan favorieten toevoegen).

2. Typ in het tekstveld Add to Favorites (Aan favorieten toevoegen) een label voor de zoekopdracht en klik op OK.

FIGUUR 6. Favorietenmenu

FIGUUR 7. Keuzemenu favorieten
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Een favoriet verwijderen

1. Selecteer Favorites (Favorieten) > Manage Favorites (Favorietenbeheer) in het rapportdatabasevenster.

FIGUUR 8. Venster favorietenbeheer

2. Selecteer het favoriet item.

Nu wordt de hele zoekopdrachtformule in het resultatenvenster weergegeven.

3. Klik op Delete (Verwijderen).

Een bevestiging zal uw te verwijderen selectie bekrachtigen. Selecteer Yes (Ja).

4. Selecteer Close (Sluiten).
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Zoekresultaten exporteren naar een HTML-bestand.

1. Selecteer Export List (Lijst exporteren) rechts van het rapportdatabasevenster.

FIGUUR 9. Exportvenster

2. Selecteer de map waarnaar u de lijst wilt exporteren.

3. Selecteer OK.

• Een pop-upvenster vraagt of de rapporten moeten worden opgenomen.
• De lijst en rapporten worden naar een HTML-bestand geëxporteerd.

De database exporteren

Naarmate de database groter wordt, is het raadzaam om de gegevens te archiveren.

1. Selecteer File (Bestand) > Export (Exporteren) in de menubalk Rapportdatabase.

2. Selecteer de map waarnaar u de lijst wilt exporteren.

3. Selecteer OK. De database wordt geëxporteerd naar het externe-opslagapparaat.
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Een database importeren

De database kan worden geïmporteerd vanaf een andere pc waarnaar deze is geëxporteerd. 

1. Selecteer File (Bestand) > Import (Importeren).

FIGUUR 10. Importvenster

2. Selecteer de map waaruit u de database wilt importeren.

3. De geïmporteerde database wordt samengevoegd met de bestaande.
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Tabletmodus
suiteHEART® Software wordt ondersteund op tablets met een 64-bits processor die draait op het besturingssysteem 
Windows 10 Professional of Windows 10 Enterprise. Lees het volgende gedeelte voor het gebruik van suiteHEART® 
Software op een tablet.

De tabletmodus inschakelen

1. Selecteer vanuit de beeldviewmenubalk Tools > Preferences (Voorkeuren) > Edit Preferences (Voorkeuren wijzigen).

2. Selecteer de tab Globale instellingen en zet de cursor in het paneel Miscellaneous (Diversen) .

3. Vink het selectievakje Tabletmodus inschakelen aan.

4. Op de rapportweergave is een toetsenbordpictogram actief, zoals weergegeven in Figuur 1.
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FIGUUR 1. Toetsenbord aan-/uitzetten

5. Wanneer een tekstveld wordt gebruikt, verschijnt een virtueel toetsenbord.

Het virtuele toetsenbord kan op de interface worden verplaatst.

6. Wanneer een selectie wordt gemaakt buiten een tekstgebied, wordt het toetsenbord gesloten.

7. Klik op  om het virtuele toetsenbord handmatig te activeren. Klik op  om het te sluiten

Beeldmanipulatietools

Als u de beeldmanipulatietools op een tablet wilt gebruiken, drukt u met een stylus of, als er een muis is aangesloten, klikt 
u met de linkermuisknop en sleept u op de tool.

Als u afbeeldingen op het tabblad Afbeeldingen opnieuw wilt rangschikken, klikt u met de rechtermuisknop en selecteert 

u het drop hand-pictogram .



suiteHEART® Software-gebruiksaanwijzing NS-03-040-0008 Versie�1    166

Bijlage

Technische referentie

Bijlage A - Referentieartikelen
Referentiebereiken zoals beschreven op pagina 37 van deze handleiding, kunnen worden bepaald op basis van de volgende 
literatuurreferenties van peer-reviews:

1. Kawel-Boehm et al, „Normal Values for Cardiovascular Magnetic Resonance in Adults and Children.” Journal of
Cardiovascular Magnetic Resonance (2015) 17:29

2. Maceira A.M. et al, „Normalized Left Ventricular Systolic and Diastolic Function by Steady State Free Precession
Cardiovascular Magnetic Resonance.” Journal of Cardiovascular Magnetic Resonance (2006) 8, 417-426.

3. Lorenz C. et al. „Normal Human Right and Left Ventricular Mass, Systolic Function, and Gender differences by Cine
Magnetic Resonance Imaging.” Journal of Cardiovascular Magnetic Resonance 1(1), 7-21, 1999.

4. Sechtem, U. et al. „Regional left ventricular wall thickening by magnetic resonance imaging: evaluation in normal
persons and patients with global and regional dysfunction.” Am. J. Cardiol. 1987 Jan 1;59(1):145-51.

5. Storey P, et al. „R2* Imaging of Transfusional Iron Burden at 3T and Comparison with 1.5T,” Journal of Magnetic
Resonance Imaging 25:540–547 (2007)

6. D.J Pennell, et al. „Cardiovascular T2-star (T2Star) magnetic resonance for the early diagnosis of myocardial iron
overload,” Eur Heart J 2001; 22: 2171-2179.
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Bijlage B - Voorbeeld van functionele analyse van scanvlak
Voor nauwkeurige functieresultaten moet de analyse worden uitgevoerd op een korte-asweergave zoals weergegeven in de eerste 
afbeelding hieronder.
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Corrigeer het scanvlakvoorschrift voor het verkrijgen van de korte-asweergave. Plakjes moeten worden voorgeschreven loodrecht op 
de lange as van de linker ventrikel met minimaal 2 plakjes boven de basis en 1 plakje na de top in de serie.
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Bijlage C - Ondersteunde fabrikanten
suiteHEART® Software is geëvalueerd met cardiale MRI-afbeeldingen van de volgende fabrikanten vermeld in de onderstaande tabel.

Fabrikant Scannertype Analysemodus

GE Healthcare Discovery MR750
Discovery MR750w
Optima MR360
Optima MR450w
Optima MR450
Signa HD
Signa HDx
Signa HDxt

Alle analysemodi

Philips Healthcare Achieva
Ingenia
Intera
Intera Achieva

Functie, myocardiale evaluatie, 
Tijdsduur, Flow, T2-mapping,  
T1-mapping, T2*

SIEMENS Aera
Avanto
Espree
Skyra
Sonata
Symphony
Verio

Functie, myocardiale evaluatie, 
Tijdsduur, Flow, T2-mapping,  
T1-mapping, T2*
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